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Q.1. A. Choose the correct Alternative. 16 
1) In Microsoft Excel spreadsheets, rows are designated as _______. 
      a) 1, 2, 3, ...                         b) A, B, C, ... 
      c) A1, B1, C1, ....               d) I, II, III, ... 
2) _____ logical function indicates TRUE only if all arguments are assessed as TRUE, and   
      FALSE otherwise.  
        a) OR                               b) AND 
        c) IF                                 d) ANDIF 
3) _______ term is used to join the selected cells in to one cell. 
       a) Filter                                 b) Wrap 
       c) Pivot                                 d) Merge 
4) A(n) ____ is a series of two or more adjacent cells in a column or row or rectangular group  
    of cells. 
      a) List                                      b) Section 
      c) Range                                 d) Area  
5) ___ command is used to close the window of Excel. 
      a) Alt+ F4                               b) Ctrl + W 
      c) Ctrl +R                                d) Ctrl+ C 
6) ____ type of chart is good for a single series of data.  
     a) Column chart                      b) Cone chart 
     c) Line chart                           d) Pie chart  
7) Press the ______ key to move the insertion point to the first cell in a row in Excel. 
      a) Page Up                             b) Page Down 
      c) Home                                d) Tab 
8) ____ is not a function in Excel.  
    a) SUM                                   b) MIN 
    c) SUBTRACT                      d) MAX 
9) _____ Excel function returns TRUE or FALSE based on two or more conditions 
        a)   =AVERAGEIFS            b) =CONCAT 
        c) =COUNTA                      d) =AND 
10) Which shortcut key is used to open the Visual Basic Editor in VBA? 

                  a) Alt + F11                                      b) Ctrl + F11 
                  c) Shift + F11                                   d) Shift + Ctrl + F11 
              
             11) _____ button has three states in VBA. 
                   a) Option button                             b) Spin button 
                   c) Push button                                  d) Command button     
           
 
 
   



 

         12) What is called double clicking an object in VBA? 
                    a) Events                                       b) Macros 
                    c) Procedures                                 d) Methods     
   
          13) VBA stands for----- 
                   a) Visual Basic for Application           b) Visual Basic Advanced 
                   c) Visual Basic for Access                   d) Virtual Basic for Application  
 
           14) What is a Pivot Table used for in Excel? 
                 a) Sorting data                  b) Organizing and summarizing large amounts of data 
                 c) Merging two tables      d) Changing the font style of a table 
 
            15) What function would you use to find the largest number in a range of cells? 
                 a) max                                                b) biggest 
                 c) highest                                            d) largest 
           16)  What is the keyboard shortcut to save a workbook in Excel? 
                 a) Ctrl + S                                          b) Ctrl + N 
                 c) Ctrl + P                                          d) Ctrl + O 
       C. Match the following          04 
                A                                         B 
        1) Merge & Centre            a] Mouse pointer changes to dark plus sign     
        2) Fill handle                     b] merges and centers contents 
        3) Up arrow key                c] center align the paragraph 
        4) Align center                  4] Align center 
 
Q. 2.  Write short notes (Any 4)                                                                    20 
         1) What is conditional formatting in Excel?  
         2) Explain the characteristics of a spreadsheet. 
         3) What is absolute cell reference in excel? 
         4) What is Database Function? Explain any four functions. 
         5) What is hyperlink? Explain steps how to create a hyperlink. 
 
Q.3. Attempt any 2(Any Two)         20 
        1) What is spreadsheet? Explain use of Pivot table & Pivot chart with example. 
       2) What is Excel function? Explain any four Mathematical Functions with its example. 
       3) What is Engineering Function? Explain any four functions with example. 
 
Q.4. Attempt any 2(Any Two)         20 
        1) Explain any five-text function with its suitable example. 
        2) What is VBA form? How to use command button and textbox in this form. 
        3) What is macro generation? Explain its Application Design.  
 
Q.5. Attempt any 1(One)          20 
       a) What is Macro in VBA? Explain how to create edit and run the macro  
           with Example.  
       b) Create a VBA form and perform following operation. 
              i) Addition                  ii) Subtraction 
             iii) Multiplication         iv) Division       
       c)  What is chart? Explain any two type’s charts with suitable example. 
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Ů̼न Ţ.१. योƶ पयाŊय िनवडा                                                                                       गुण :१०                              

१. १९३६ मȯे -------------- अİˑȕात आले 

अ. ऑल इंिडया रॅिडओ ब. इंिडयन Űॉडकाːीगं कंपनी  क. आकाशवाणी  ड. यापैकी नाही 

2. संपादकीय पानाǉा िनयोजनासाठी कोण जबाबदार आहे 

अ. संपादक      ब. बातमी संपादक   क. įरपोटŊर      ड. िनवासी संपादक 

३. भारतात दूरदěŊनची सुŜवात ---------- मȯे झाĖी   

अ. १५ सेɐेɾर १९५९   ब. १४ एिŮĖ १९२० क. १७ जून १९२०      ड.१५ माचŊ १९२० 

४. ------------हे सोलापुरातील खाजगी ʩावसाियक रेिडओ ːेशन आहे  

अ.  माय एफ एम ९५  ब. आकाशवाणी  क. रेिडओ िमरची   ड. रेड एफ एम 

५. 2LO आहे ----------------- 

अ. इं̑Ėंडचे पिहĖे रेिडओ ːेěन    ब. टी वी चानĖ क. एफ एम  ड. वृतपũ  

६. ---- हे आरजेचे पूणŊ ŝप आहे 

अ. रेिडओ जॉकी ब. įरअĖ जॉक क.  įरअĖ जॉकी ड. यापैकी  नाही  

७. इंटरनेटमȯे कनेƃ केĖेʞा ƒायंटĖा ---- ŮोटोकॉĖ आयपी पȅा िनयुƅ करतो 

अ. डीएचसीपी  ब. आयपी क. आरपीसी  ड. आरएसʬीपी 

८. युिनकोड हे एक ----- 

अ. ऑपरेिटंग िसːम       ब. सावŊिũक भाषा क. अडŌ ोईड अनुŮयोग     ड. यापैकी काहीही नाही 

९. ई-मेĖ पूणŊ ŝप 

अ. इĖेƃŌ ॉिनक मेĖ ब. इĖेƒेİƃक मेसेज  क. इĖेİƃŌ कĖ मोड ड. यातीĖ नाही 

१०. पुढीĖपैकी कोणता ŮोटोकॉĖ इंटरनेटमȯे वापरĖा जातो 

अ. एचटीटीपी ब. डीएचसीपी क. डीएनएस ड. डीएनएस, एचटीटीपी आिण डीएनएस 
 

  



 

 

Ů̼न Ţ.२. संिƗɑ उȅरे दया  ( पाच पैकी कोणतेही  चार )                                          गुण :१२                                                                                                                 

१.  रेिडओची गुणवैिě̽Ǩे ˙ʼ करा  

२. पũकाįरतेमȯे इंटरनेटचे महȕ ˙ʼ करा 

३. िचũपट िनिमŊती ŮिŢया ˙ʼ करा  

४. इंटरनेट िह संकʙना ˙ʼ करा 

५. रेडीओ हे माȯम ˙ʼ करा  

 

Ů̼न Ţ.३. िटपा िĖहा ( तीन  पैकी कोणतेही  दोन )                                                   गुण :०८            

१. फेसबुक  

२. िचũपट रसˢाद  

३. टेिĖİʬजन  

 

Ů̼न Ţ.४. सिवˑर उȅरे िĖहा   ( कोणतेही  तीन )                                                  गुण :३०            

१. Ůसार माȯमांची कायŊ िवषद करा  

२. रेिडओचा इितहास ˙ʼ करा  

३. ऑनĖाईन वृȅपũाचे महȕ िवषद करा  

४. िचũपट िनिमŊतीतीĖ घटकांची चचाŊ करा  
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Ů̼न Ţ.१. योƶ पयाŊय िनवडा                                                                                       गुण :१०                                                                                                                 

1. बातमीǉा पिहʞा परीछेदाĖा ----------- ʉणतात  

अ. िěरोभाग    ब. मथळा क. ěीषŊक   ड. जनसंपकŊ  

२.  अŤĖेखाǉा पानावरीĖ मजकुराचे िनयोजन ------- करतात   

अ. वृȅसंपादक  ब. वाताŊहर  क. संपादक       ड. यापैकी नाही 

३.  बातमीची रचना ------------- सारखी असते  

अ.उĖटा िũकोण  ब. सुĖटा िũकोण  क.आयात  ड. गोĖ  

४. ए.बी.सी. वृȅपũाǉा ---------चे मोजमाप करते 

अ. वाचकवगŊ  ब. खप  क. महसूĖ     ड. यापैकी नाही  

५. मोǬा वृȅपũात नोकरी करीत असĖेʞा आिण राǛाǉा राजधािनतीĖ वाताŊकन करणायाŊĖा -----

----- ʉणतात  

अ. İ˓ंजर  ब. वृȅŮतीिनधी  क. मुƅ पũकार   ड. िवěेष Ůितिनधी  

६. बातमीचे मूʞ ----------- वŝन ठरते    

अ. ताजेपणा    ब. नजीकता  क. महाȐ ड. वरीĖ सवŊ  

७. पूवŎची बातमी पुढे नेणा̴या बातमीस -------- ʉणȅात  

अ.  पा̼वभूमी  ब.  आढावा  क. पाठपुरावा  ड.  संयुƅ बातमी  

८. िवकासासंबधी केĖेĖे Ėेखन -------- असते  

अ. िवकासवाताŊ  ब. ĖेखमाĖा  क. बातमीपũ  ड. इंटरनेट 

९. बातमी िĖिहताना नेहमी ĖƗात ठेवावयाची बाब ʉणजे बातमी ---------- असावी  

अ. वˑुिनʿ  ब. गंुतागंुतीची   क. अĖंकाįरक   ड. यापैकी नाही 

१०. एकपदरी  मथʨाĖा ---------- ʉणȅात  

अ. पिǥका  ब. महािěषŊक क. ːोरी  ड. यापैकी नाही 

 



 

Ů̼न Ţ.२. संिƗɑ उȅरे दया    ( पाच पैकी कोणतेही  चार )                                          गुण :१२                                                                                                                 

१.  बातमीचे बदĖते ˢŝप ˙ʼ करा   

२. पũकाराचे ŠȞे व Ůकार ˙ʼ करा 

३. पũकाराǉा अंगी कोणते कौěʞ असणे गरजेचे आहे   

४. पũकारांसाठी उपयुƅ असणारी साधने ˙ʼ करा   

५. मुĖाखतीचे Ůकार ˙ʼ करा  

 

Ů̼न Ţ.३. िटपा िĖहा    ( तीन  पैकी कोणतेही  दोन )                                                   गुण :०८            

१. पũकारांचे  कायŊ   

२. संपादकीय संˋार  

३. संपादकीय Ėेख   

 

Ů̼न Ţ.४. सिवˑर उȅरे िĖहा   ( कोणतेही  तीन )                                                  गुण :३०            

१. वृȅĖेख ʉणजे काय, वृतĖेखाǉा िविवध Ůकारांचा ěोध Ȩा 

२. नभोवाणी साठी बातमी Ėेखन कसे कराĖ ते सोदाहरण ˙ʼ करा  

३. ऑनĖाईन वृȅपũाचे महȕ िवषद करा  

४. टेिĖİʬजनसाठी Ėेखन क̼या Ůकारे ते ˙ʼ करा  
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Ů̼न १. योƶ पयाŊय िनवडा. Ůȑेकी एका गुणाचे दहा Ů̼न    गुण १० 
१) घोटाळा आिण űʼाचार या संदभाŊतीĖ बातʄांचा समावेě-----पũकाįरते मȯे होतो. 
अ) पीत पũकाįरता                         ब) िवकास पũकाįरता  
क) ěोध पũकाįरता                         ड) यापैकी नाही  
 
२) पũकाįरतेतीĖ ‘िबट’ या ěɨाचा अथŊ --------असतो. 
अ) बातमीचे मथळे                           ब) पũकार िनयिमतपणे पूकŊ ण करत असलेले Ɨेũ िकंवा िवषय 
क) Ůकािशत कथेमȯे केलेली सुधारणा          ड) वतŊमानपũाची िवशेष आवृȅी 
 
३)एफ.आय.आर. मधीĖ तपěीĖवार ----------Ůकारǉा बातʄा आधारĖेʞा असतात. 
अ) आिथŊक             ब) राजकीय          क) सांˋृितक        ड) गुɎेगारी                                               
  
४) पũकाराची Ůाथिमक भूिमका--------असते. 
अ) वाचकांचे मनोरंजन करणे                             ब) सरकारी धोरणांचा Ůचार करणे  
क) अचूक आिण संतुिलत बातʄा देणे                 ड) उȋादनांची जािहरात करणे  
  
५) ------हे बातमीचे मूʞ आहे. 
अ)महाȐ        ब)नजीकता       क)संघषŊ     ड)यापैकी सवŊ    
 
६) पयाŊवरणीय वाताōकन -----याǉाěी संबंिधत आहे: 
अ) राजकीय घटना                       ब) हवामान बदĖ, Ůदूषण आिण संवधŊन सम˟ा 
क) ěेअर बाजारातीĖ कĖ            ड) सेिĖिŰटी बातʄा 
 
७)--------हे पũकारांचे साधन आहे. 
अ) मोबाईĖ       ब) संगणक          क) कॅमेरा        ड) यापैकी सवŊ  
 
८) आरोƶ िवषयक वाताōकनासाठी ------------आव̼यक आहे. 
अ) आिथŊक ǒान                      ब) राǛěा˓ातीĖ पा̼वŊभूमी  
क) Ţीडा िनयमांचे ǒान            ड) वैȨकीय संǒा, टŌ Őड आिण सावŊजिनक आरोƶ सम˟ा समजून घेणे  
 
९)नाटक आिण दूरिचũवाणीवरीĖ मािĖका संदभाŊतीĖ बातमी ही-----पũकाįरतेǉा Ůकारात मोडते. 
अ) मनोरंजन            ब)ěोध            क) िवकास           ड) यापैकी नाही 
१०)   ----- हा बातमीचा Ůकार नाही. 
अ) कठीण बातमी      ब) मृदू बातमी      क) मनावी ˢार˟ाची बातमी       ड) यापैकी नाही  
  



 

 
Ů̼न २. संिƗɑ उȅरे Ȩा . Ůȑेकी तीन गंुणाचे पाच पैकी चार सोडवा.  गुण १२ 
१) कृषी पũकारेती समोरीĖ आʬाने ˙ʼ करा? 

२) पũकार पįरषद ʉणजे काय? 

३) राजकीय वाताōकनासाठी कोण-कोणते ˓ोत उपयुƅ ठरतात? 

४) महापािĖकेचे वाताōकन करताना कोण-कोणȑा घटकांचा समावेě करता येतो.  

५) Ţीडा वाताōकन करत असताना कोणा-कोणाǉा मुĖाखतीचंा समावेě करता येते? 

 
Ů̼न ३. टीपा िĖहा. Ůȑेकी चार गंुणाचे तीन पैकी दोन सोडवा.   गुण ०८  
१) Ťामीण भागातीĖ सम˟ा आिण पũकारांची भूिमका  

२)िजʥा पįरषदेǉा िविवध िवभाग आिण कामकाजाचे ˢŝप  

३) आरोƶ िवषयक वाताōकन  

 
Ů̼न ४.सिवˑर उȅरे िĖहा.  
Ůȑेकी दहा गंुणाचे चार पैकी कोणतेही तीन दीघŖȅरी  Ů̼नाची उȅरे िĖहा.  गुण ३०  

       

१) ’पũकाįरतेचे बदĖते ˢŝप’ या िवषयावरती सिवˑर िĖहा. 

२) वाताŊहरांǉा जबाबदा̴या कोण -कोणȑा आहेत? 

३) पयाŊवरण जतन आिण संवधŊनात Ůसार माȯमांची भूिमका ˙ʼ करा?  

४) शोधपũकाįरता ही संकʙना ˙ʼ करा. उदाहरण Ȩा. 
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Ů̼न Ţ. १ योƶ पयाŊय िनवडा.        गुण-१०  
१. वृȅपũात ------- हे Ůामुƥाने अŤĖेख िĖिहत असतात.              

अ)मुƥ संपादक ब) उपसंपादक   क)वृȅसंपादक     ड)यापैकी नाही  

२. -------  हा  अŤĖेख Ėेखनाचा Ůकार नाही.         

अ) टीकाȏक   ब) पाठपुरावा         क) Ůěंसाȏक     ड) भयदायी 

३. ----- हा बातमी रचनेतĖा घटक आहे.                                                               

अ) Ůˑावना     ब) पा̼वŊभूमी      क)मथळा     ड) यापैकी सवŊ 

४. ʩाकरण, ěुȠĖेखन आिण िवरामिचɎांǉा चुका सुधारǻाĖा ----- ʉणतात. 

अ) आराखǰाची रचना  ब) संपादन  क) मथाळा Ėेखन  ड) यापैकी नाही 
      
५. Ůȑेक ̾थािनक वाताŊहरांस केĖेʞा  कामिगरीǉा वाटपाचा तपěीĖ  असाईनमŐट डायरीत  ------- 

िĖिहतात.      

अ)  संपादक  ब) वृȅ संपादक  क) सहायक संपादक  ड) उपसंपादक 

६. ----हे पेजीनेěनचे सॉɝवेअर नाही.  

अ) इन िडझाइन  ब) ƓाकŊ एƛŮेस क) एिडयस  ड) यापैकी नाही   

७. ----- हे संपादकाचे Ůाथिमक काम आहे.  

अ) जािहराती िĖिहणे    ब) ˙ʼता आिण अचूकतेसाठी आěयाची तपासणी करणे  

क) मुĖाखती घेणे         ड) यापैकी नाही        

 ८. िवȨाथŎ आंदोĖनाǉा बातमीचे --------हे वाताŊमूʞ आहे. 

अ)पįरणाम   ब)संघषŊ   क)महȕ   ड)महाȐ  

 ९. वृȅपũात छापǻायोƶ बातʄांǉा िनवडीचा अंितम िनणŊय ----करतात. 

अ)संपादक    ब) ʩव̾थापक    क)वाचक   ड) यापैकी नाही  

१०. वृȅपũाचे मुūक,Ůकाěक आिण संपादक यांचा तपěीĖ ----------िदĖा जातो. 

 अ)बाय Ėाईन  ब) ˋाय Ėाईन    क) िŮंट Ėाईन   ड)यापैकी नाही  

  



 

 

Ů̼न Ţ. २ संिƗɑ उȅरे Ȩा.(कोणतेही चार)       गुण-१२  

१. वाचकांची पũे यावरती सिवˑर िĖहा. 

२. ˛ुटĖेखनाचे महȕ ˙ʼ करा.  

३. ‘सहसंपादकाची जबाबदारी’ या िवषयावरती संिƗɑ टीप िĖहा. 

४. ˛ुटĖेखन ʉणजे काय?  

५. साईड आिटŊकĖ ʉणजे काय?  

 
Ů̼न Ţ. ३ िटपा िĖहा.(कोणतेही दोन)       गुण-०८  
१. संपादकीय पानाचे िनयोजन  

२. िवěेष Ůितिनधी  

३. वृȅपũातील भाषा  

 

Ů̼न Ţ. ४ सिवˑर उȅरे िĖहा. (कोणतेही तीन)      गुण-३०  
१. ‘संपादकीय पानाचे महȇ ’यावर टीप िलहा.  

२. मुƥ संपादकाǉा जबाबदा̴या कोणȑा आहेत? 

३. अŤĖेखांचे Ůकार कोण-कोणते आहेत? 

४. संपादकीय िवभागाची रचना आिण कायő ˙ʼ करा. 

 

*************** 
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ᮧ᳤ 1 ला.  ᳯरका᭥या जागा भरा.        (20) 
1). ............हा ᱶᮨ च िवचारवंत होता. 

A) ᱧसो      B) ᳰददरो     C) कालᭅमा᭍सᭅ    D) ᭠यूटन 

 2) मादाम मॉ᭠टेसरी चा ज᭠म .........ला झाला 

A) 30 ऑगÖट 1870 C) 31 ऑगÖट 1870 B) 1 ऑगÖट 1870 D) 21 ऑगÖट 1870 

3) अनुताई वाघ यांना .......हा पुर᭭कार ᳰदला गेला. 

A)   आदशª िशि±का B) आदशª मिहला C) आदशª कामगार D) आदशª पालक  

4) बालवाडीचा ......हा कᱶ ᮤᳲबंद ूआहे. 

A) बालक B) पालक C) समाज  D) धमᭅ   

5(  ...........᭥हणजे घर व शाळा यांना जोडणारा दवुा.    

A)     पयᭅटन B) हॉि᭭पटल C) िनसगᭅ पᳯरसर D)     बालवाडी 

6) मॉ᭠टेसरी प᳍त ही ......वषाᭅ᭒या मुलासाठी असते. 

A) तीन ते सहा  B) तीन ते पाच  C) तीन ते आठ  D) तीन ते नऊ 

7) ᭭वयं᭭फूतᱮ ᭥हणजे .... होय.  

A)  ᮧेरणा B) ᭟येय C) वचन D) िव᳡ास 

8) बालवाडी िह एक .........आहे.  

A)  सामािजक संÖथा  B) ᮕामपंचायत  C) घरसं᭭था  D)   कुटंुबसं᭭था  

9) बाल ᭠याय अिधिनयम ....... ला संमत झाला  

A) 1987  B) 1987  C) 1986  D) 1988 

10) ..............᭥हणजेच ᭄ानᱶᳰᮤय व कणेᳶ᭠ ᭅᮤय यांचा िवकास होय.  

A) कᱶ ᮤीय िवकास  B) लोक िवकास C) सामिजक िवकास  D) कुटंुबिवकास  

ᮧ᳤ 2. ᳯटपा  िलहा.  (कोणतहेी 4(        )20(            

1) मॉ᭠टेसरी प᳍त 

2) रा᳦ीय वᱫृीचा िवकास 



 

3) डेड ᭭टॉक रिज᭭टर 

 4) िनयिमत वै᳒कᳱय तपासणी 

5) भावनांचा िवकास.    

 6) भाषा िवकास 

 

ᮧ᳤ 3 रा. सिव᭭तर उᱫरे िलहा. ( कोणतेही 2(       )20( 

1) ᭭वावलंबन कसा असावा ? 

2) बालवाडी सािह᭜याचे महᱬव  ? 

3) बालकां᭒या चांग᭨या सवयी कोण᭜या?   

ᮧ᳤ 4 था.  ᳰदघᲃतरी उᱫरे  िलहा. (कोणतेही 1(       )20( 

1) सामािजक िवकास Ìहणजे काय? 

2)   बालवाडी ची इमारत कशी असावी?  

 ᮧ᳤ 5  वा.  बाल िशᭃणाची मूलतᱬवे ᭭प᳥ करा.                       )20( 

 

********************************** 
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ĢƘ 1 ला. िरकाÇया जागा भरा.        (20)      
1. .......... Ģमुख अÆयास पǉती आहे.  

A) मानसशाǥ B) समाजशाǥ C) इितहास D) रा¶यशाǥ 
 

2. ........ ही मानसशाǥाचे Ģमुख अÆयास पǉती आहे.  

A) समाजशाǥ B) आ¾मिनरी©ण C) इितहास   D) भगूोल 
 

3. ........... ही  िश©ण ĢिĎयेचे ची मÁयवतȓ कÊपना आहे. 
A) महािवǏालय B) समाज C) िवǏालय D) िवकास  

 

4. शारीिरक िवकाकासाचे Ģकार...... आहेत. 

A)    सहा B) चार C) पाच   D) आठ 
 

5. ......... हा  माणसा´या जीवनातील माणसा´या जीवनातील अंग आहे . 

A) भाविनकता   B) Ģसंगीतता C) सहनशीलता D) उदासीनता 
 

6. बाÊयावÎथा............ वषɕपयȊत आहे . 

A) A) 0-9    B)0-6    0-8    C)0-1 D) 0-4  
 

7. ªानĐहण कर½याची पिहली पायरी Çहणजे .......   

A) संवदेना B) भाविनकता C) उदासीनता D) सहनशीलता 

8. फुफुसाची वाढ....... वषȝमÁये जलद गतीने होते. 

A) चार B) पाच C) सहा    D) साथ 
 

9. मॅकडुगलने  ....... सहजĢवृǄी सािंगतलेÊया आहेत. 

A) चौदा B) पंधरा C) सोळा D) वीस  

10. अवधानाचे आंतिरक घटक ...... आहेत.  

A) सहा B) साथ C) आठ D) नऊ 



 

 
ĢƘ 2 रा.  िटपा िलहा. (कोणतेही 04)       (20)   

1. अिभǗची 

2. Îमरण 

3. अवधान 

4. बालकां́ या दोन सामािजक गरजा   

5. मानवी िवकास            

6. Ģेरणा 

ĢƘ 3 रा .    सिवÎतर  उǄरे िलहा. (कोणतेही दोन)     (20) 
1. मानवी  िवकासाचे  फायदे सागंा ? 

2. Îवावलंबीचे  उिǈÍट सागंा  ?   

3. भावनाचें Ģकार िकती आहेत ? 

ĢƘ 4 था . िदघȘतरी उǄरे िलहा. (कोणतेही एक)     (20) 
1. लहान मुलाचं े Îव´छतेची साधने कशी वापरावीत 

2. अनुवशं मÁये येणारे गुणधम« कोणते 

ĢƘ 5 वा बालका´या  िवकासाचे Ģकार सागंा ?      (20) 
 

************************************************** 
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 ĢƘ 1)  िरकाÇया जागा भरा.    (20)         
1) जीभ .......असणे हे चागंÊया आरो±याचे ल©ण आहे. 
  A) गुलाबी     B) िपवळी     C) िनळी     D) िहरवी  
 

2) लहान मुलाचंे कपडे श¯यतो .........असावते.     
 A) सुती   B) गरम   C) थंड       D) जीÂस िविहरीत   
 

3) फळे खाणे हे ........आहाराचे ल©ण आहे. 
 A) सकस   B) िनÍकृÍट   C) कमी दजɕचे     D) जीवनस¾व 
 

4) पोिलओची ...........वषɕपयȊत देतात.  
A) तीन ते नऊ   B) नऊ ते बारा    C) बारा ते पंधरा    D) तेरा ते पंधरा    
 

5) ......मुळे गालगंुड होतो. 
 A) िजवाणूमळेु    B) िवषाणमुूळे     C) पा½यामुळे     D) फळामुळे 
 

 6) जे कामेकां́ या सहवासात आÊयानंतर जे रोग होतात ¾यानंा .......Çहणतात. 
 A) संसग«जÂय B) सदȓ C) ताप D) कावीळ 
 

 7)  .........बÎूटर ही दीड ते दोन वषɕत िदली जाते.  
A) बीसीजी B) टीसीची C) एमसी D) आरसीची 
 

 8) जÂमापासून तीन मिहÂयानंतर ......िह लस देतात.  
A) डीटीपी      B) टीपीटी    C) पीसर   D) डीचीपी 
 

 9) हाडमोडी Çहणजचे ...... होय.  
A) हÎतेबगं B) कावीळ C) मलेिरया D) टायफॉईड 
 



 

10) राĝी .... खाऊ नये.  
A) गोड B) ितखट C) आंबट D)   तुरट 
 

ĢƘ 2 रा.  (अ) िटपा िलहा. (20) ( कोणतेही 04 )   
1) लहान मुलानंा खेळ.                      
2) हवा Ģदूषण 
3) समतोल आहार 
4) Îव´छ पाणी िप½याचे फायदे. 
5) पोिलओ पासनू वाच½याचे उपाय 
6). Îतनपानाच ेफायदे 
 

 ĢƘ 3 रा.  सिवÎतर  उǄरे िलहा.  ( कोणतेही 2)         (20) 
1)  Ģदूषणचे Ģकार िलहा? 
2) सकस व पौȎÍटक अƐ कोणते ते िलहा ? 
3) बालकाला आहार कोण¾या पǉतीचा Ǐावा ?  
 

ĢƘ 4 था.  िदघȘतरी ĢƘ.  (कोणतेही एक) (20) 
1) लहान मुलानंा Îव´छतेचे मह¾व कसे सांगाल? 
2) हवा Ģदूषण कशा पǉतीने आपण रोखू शकतो? 
 

ĢƘ. 5 वा.  िटपा िलहा .  (20) 
1)  बालका´या आरो±यावर पिरणाम करणारे घटक कोणते ते िलहा? 

 
*************************************************** 
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ĢƘ 1 ला.  िरकाÇया जागा भरा.  (20) 
1. Îवतःच ेकाम Îवतः करणे Çहणजे _____होय. 

A) Îवावलंबन  B) Îवाथ«  C) Ģेरणा   D) िवǚास 

2. _____मिहÂयामÁये नाव नȗदणी असते.  

A)     मे   B) जुल ै  C) जून   D) फेĤुवारी   

3. 3)  बडबड गीता मधून _____िवकास होतो. 

A) िलह½याचा  B) बोल½याचा  C) वाच½याचा  D) गा½याचा  

4. 4) _____वगɕत रोज नऊ िनȌमतीचा आनंद िमळतो. 

A) भाषा B) गिणत   C) शाĝ D) संगीत 

5. 5) _____गाणी लाव½यामुळे बालकांमÁये सहकायɕची वǄृी वाढते. 

A)  समहूगीत   B) िनसग«गीत   C) पाǙा¾यगीत  D) बालभावगीत 

6. 6) राÍĘ गीतामळेु बालकामंÁय े_____भावना वाढते. 

A) राÍĘĢेमाची   B) िवǚासाची  C) िमĝ¾वाची  D) सहानुभतूीची 

7. 7) बालकां́ या मनातील गीत Çहणजे _____होय. 

A) बालभावगीत B) समहूगीत  C) पाǙा¾यगीत  D) िनसग«गीत 

8. 8) बालवाडी काढ½यासाठी कमीत कमी _____कुटंुबे असावीत. 

A)200 ते 250 B)220 ते 230 C)300 ते 400 D)500 ते 600 

9. _____ही लेखनाची तयारी आहे. 

A) पताके   B) खेळ C) सुिवचार D) गाणे 

 

 



 

 

10.  26 जानेवारी हा भारताचा _____आहे. 

A) ĢजासǄाक िदन  B) ÎवातंĂयिदन   C) लोकशाहीिदन  D) कामगारिदन  

 ĢƘ 2 रा. िटपा िलहा.    ( कोणतेही 4) (20) 
1. संगीत 

2. बडबड गीते  

3. बरेीज वजाबाकी संबोध 

4. बठेै खेळ 

5. बालकांमÁये सहकायɕची जोपासना िनमɕण करणे  

6. बालकाचे ÎवावलÇबन ना½याचा पिरचय.             

ĢƘ 3 रा . सिवÎतर  उǄरे िलहा . कोणतेही (2) (20) 
1. सािंघक खेळाचा फायदा सांगा 

2. सम-िवषम कÊपना लहान मुलांमÁये कशी िवकिसत होते  

3. टोपली चा खेळ कशा Îवǘपाचा असतो 

ĢƘ4 था.  िदघȘतरी उǄरे  िलहा.  (कोणतेही एक)   ( 20) 
1. वªैािनक खेळणीचे फायदे 

2. ªानȂिğयांचा िश©णामÁये उǈेश कसा सफल होतो 

 
ĢƘ 5 वा.  बालकाचा िवकास बालवाडी´या साǩाने कशा Ģकारे करता येतो ते ÎपÍट  करा?   ( 20)         

 
*************** 
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ĢƘ 1ला.  िरकाÇया जागा भरा.         (20) 
1) बाल िश©णाची चळवळ सुǗ होऊन _______अिधक काळ लोटला आहे.  
A) दीडशे वषȝहून B) चारशे वषȝहून C) तीनशे वषȝहून D) पाचशे वषȝहून 
 

2) लुईस Ĥेल याने_______शोध लावला. 
A) पेनचा  B) शूÂयाचा  C) मोटारीचा  D) Ĥेल िलपीचा   
 

3) बाल अिधिनयम _______ ला झाला.  
A) 1986  B)1987  C)1988  D)19993)  
 

4) िश©णापासून दूर असलÊेया मलुांना _______ बालक असं संबोधलं जातं. 
A) विंचत  B) बािधत  C) अिशि©त  D) िशि©त 
 

5) _______ हा िश©णाचा कȂ ğȋबदू आहे. 
A) पालक  B) बालक  C) समाज  D) संÎथा 
 

6) _______ वषɕपयȊतची मलेु बालवाडीत येत असतात. 
A) तीन ते सहा   B) चार ते पाच C) सहा ते साथ D) तीन त ेदहा 
 

7) बालवाडी मÁय ेबालकांचा _______ िवकास होतो. 
A) सवȝगीण B) कमी Ģमाणात C) जाÎत Ģमाणात D) कमी जाÎत 
 

8) _______हे सुǉा एक Ģकारचे छंद कȂ ğच आहे. 
A) बालभवन B) समाजभवन C) सांकृतीकभवन D) मातापालकभवन  
 

9) _______ही जगातील Ģमुख समÎया आहे.  
A) लोकस°ंया िवÎपोट B) Ģदूषण      C) नदी Ģदूषण   D) वायĢूदूषण 
 

10) िरमांड होम लाच _______असे Çहणतात. 
A) Îवीकार Đह ȋकवा सुधार Đह B) बालभवन C) समाजभवन D) सांकृतीकभवन   
 
 

ĢƘ 2 रा.  िटपा िलहा. (कोणतेही ०३)        (20) 
1) अपंगा´या गैरसोय 
2) समाज िश©ण 



 

3) बालक कÊयाण 
4) लोकसं°या िश©ण 
5) पयɕवरण 
6)  लोकसं°या िवÎपोट   
 

ĢƘ 3 रा. सिवÎतर उǄरे िलहा . कोणतेही (०३)       (20) 
1) बालकां́ या शाळेशी जागेची समÎया? 
2) िनराधार बालकांना िश©ण कसे Ǐाव?े 
3) बालवाडी कȂ ğचे फायदे?       
  

ĢƘ 4  था. िदघȘतरी उǄरे िलहा. ( कोणतेही 1)       (20) 
1)  मोǸा कुटंुबाचे दोन तोटे सांगा?  
2) बालकां́ या समÎया सांगा?  
 
ĢƘ 5  था.  िदघȘतरी उǄरे  िलहा.        (20) 
 सामािजकǓÍǷा विंचत बालकांची िश©णाचे मह¾व ÎपÍट करा  ? 
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Question 1. Fill in the blanks.       (20) 
1). _______was a French thinker. 
A) Rousseau   B) Diderot   C) Karl Marx   D) Newton 
 

2) Madame Montessori was born on _______ 
A) 30 August 1870  B) 1 August 1870  C) 31 August 1870  D) 21 August 1870 
 
3) Anutai Wagh was given the _______award. 
A) Ideal Teacher  B) Ideal Woman  C) Ideal Worker  D) Ideal Parent 
 
4) The _______is the focal point of kindergarten. 
A) Child   B) Parent   C) Society   D) Religion 
 
5) _______means the link between home and school. 
A) Tourism   B) Hospital   C) Nature area  D) Kindergarten 
 
6) Montessori method is for _______year-old children. 
A) Three to six  B) Three to five  C) Three to eight  D) Three to nine 
 
7) Spontaneity means _______yes. 
A) Inspiration   B) Goal   C) Promise   D) Faith 
 
8) Kindergarten is a _______ 
A) Social institution  B) Gram Panchayat  C) Household institution    D) Family institution 
 
9) Juvenile Justice Act was passed in _______ 
A) 1987   B) 1987   C) 1986   D) 1988 
 
10) _______means the development of the sensory and motor organs. 
A) Central development  B) People development  
C) Social development  D) Family development 
 
Question 2. Write notes. (Any 4)       (20) 
1) Montessori Method 

2) Development of National Attitude 

3) Dead Stock Register 

4) Regular Medical Check-up 

5) Development of Emotions. 

6) Language Development 



 

 
Question 3rd. Write detailed answers. (Any 2)     (20) 

1) How should self-reliance be? 

2) Importance of kindergarten literature? 

3) What are the good habits of children? 

 

Question 4th. Write long answers. (Any 1)   (20)  

1) What is social development? 

2) How should the kindergarten building be? 

 

Question 5th. Explain the basics of early childhood education   (20) 

 
**************************** 
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Question 1. Fill in the blanks.       (20) 

1) ________ is the main method of study. 

A) Psychology  B) Sociology   C) History   D) Political Science 
 

2) ________ is the main method of study of psychology. 

A) Sociology  B) Introspection  C) History   D) Geography 
 

3) ________ is the central idea of the educational process. 

A) College   B) Society   C) School   D) Development 
 

4) Types of physical development are________ 

A) Six    B) Four   C) Five   D) Eight 
 

5) ________ is the part of human life in human life. 

A) Emotionality  B) Situationalism  C) Tolerance   D) Indifference 
 

6) Infancy is up to________ year. 

A) 0-9    B)0-6 0-8   C)0-1    D) 0-4 
 

7) The first step in acquiring knowledge is ________ 

A) Sensation   B) Emotionality  C) Indifference  D) Tolerance 
 

8) Lung growth occurs at a rapid rate in the years of________ 

A) Four   B) Five   C) Six    D) Companion 
 

9) McDougall has said ________ instincts. 

A) Fourteen   B) Fifteen   C) Sixteen   D) Twenty 

 

10) The internal components of attention are ________ 

A) Six    B) Companion  C) Eight   D) Nine 
 

  



 

 

Question 2nd. Write notes. (Any 04)      (20)  

1) Aptitude 

2) Memory 

3) Attention 

4) Two social needs of children 

5) Human development 

6) Motivation 
 

Question 3rd. Write detailed answers. (Any two)     (20) 

1) Mention the benefits of human development? 

2) What is the goal of self-reliance? 

3) What are the types of emotions? 
 

Question 4th. Write long answers. (Any one)     (20) 

1) How to use hygiene tools for children 

2) What are the characteristics that come in genes 
 

Question 5th. What are the types of child development?    (20) 
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Question 1) Fill in the blanks.        (20) 

1) A tongue _______ is a sign of good health. 

A) Pink  B) Yellow   C) Blue  D) Green 
 

2) Children's clothes should preferably be ______ 

A) Cotton  B) Hot   C) Cold  D) Jeans in the well 
 

3) Eating fruits is a sign of ______diet. 

A) Healthy  B) Poor  C) Low quality D) Vitamin 
 

4) Polio is given up to ______years. 

A) Three to nine  B) Nine to twelve  C) Twelve to fifteen  D) Thirteen to fifteen 
 

5) ______causes mumps. 

A) Bacteria  B) Virus   C) Water  D) Fruit 
 

6) Diseases that occur after coming into contact with people are called ....... 

A) Infectious  B) Cold  C) Fever  D) Jaundice. 
 

7) ______booster is given at one and a half to two years. 

A) BCG  B) TC    C) MC   D) RC 
 

8) After three months of birth ......this vaccine is given. 

A) DTP   B) TPT   C) Psor   D) DCP 
 

9) Hamdodi means ______yes. 

A) Hastebang   B) Jaundice   C) Malaria   D) Typhoid 
 

10)  Do not eat ______at night.  

A) Sweet   B) Pungent   C) Sour   D) Astringent 

 

  



 

 

 

Question 2nd. (a) Write notes. (Any 04)        (20) 

1) Games for young children. 

2) Air pollution 

3) Balanced diet 

4) Benefits of drinking clean water. 

5) Measures to protect against polio 

6). Benefits of breastfeeding 

 

Question 3rd. Write detailed answers. (Any 2)      (20) 

1) Write the types of pollution? 

2) Write what are the healthy and nutritious foods? 

3) What type of food should be given to the child? 

 

Question 4th. Long question. (Any one)       (20) 

1) How will you explain the importance of cleanliness to young children? 

2) How can we prevent air pollution? 

 

Question 5th. Write notes.         (20) 

1) Write the factors that affect the health of a child? 

 

************************** 

  



 

 
NAAC Accredited-2022 
B++ Grade (CGPA 2.96) 

Punyashlok Ahilyadevi Holkar Solapur University, Solapur 

Skill Development Centre 
 

Certificate Course: - “Certificate Course in Montessori Teacher Training” 
Day: - Thursday Time: - 11.00 to 02.00 
Date: - 13/02/2025 Mark: - 100 
Subject: - Method of Child Education Paper: - 4 
Instructions: - 1.  All Questions are compulsory. 
                          2.Right side numbers indicate Marks 

 

 
Question 1. Fill in the blanks.         (20) 
1) Doing your own work means _______ Yes. 

A) Self-reliance  B) Selfishness  C) Inspiration   D) Faith 
 

2) _______ Registration is done in the month. 

A) May   B) July   C) June   D) February 
 

3) Through the babbling geet _______ development occurs. 

A) Writing   B) Speaking   C) Reading   D) Singing 
 

4) _______ The joy of creating nine creations every day in the classroom. 

A) Language   B) Mathematics  C) Science   D) Music 
 

5) Playing _______ songs increase the attitude of cooperation among children. 

A) Group songs  B) Nature songs  C) Western songs  D) Children's songs 
 

6) National anthem increases the feeling of _______ in children. 

A) Patriotism   B) Faith   C) Friendship   D) Sympathy 
 

7) The song in the mind of children is _______ Yes. 

A) Children's song  B) Group song  C) Western song  D) Nature song 
 

8) There should be at least _______ families to open a kindergarten. 

A)200 to 250   B)220 to 230   C)300 to 400   D)500 to 600 
 

9). _______ This is preparation for writing. 

A) Flags   B) Games   C) Thoughts   D) Songs 

 

10) 26th January is India's _______ 

A) Republic Day  B) Independence Day  C) Democracy Day  D) Labour Day 
 

  



 

 

Question 2nd. Write notes. (Any 4)        (20) 

1) Music 

2) Rhymes 

3) Addition and subtraction concepts 

4) Sitting games 

5) Cultivating cooperation among children 

6) Child self-reliance Introduction to coins. 
 

Question 3rd. Write detailed answers. Any (2)      (20) 

1) State the benefits of team play 

2) How does even-odd idea develop in young children 

3) What is the nature of the basket game 
 

Question 4th. Write long answers. (Any one)       (20) 

1) Benefits of scientific toys 

2) How does the purpose of sensory organs in education succeed 
 

Question 5th.  

Explain how the development of a child can be done with the help of kindergarten?  (20) 
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Question 1. Fill in the blanks.        (20) 
1) The movement of early childhood education has been going on for more than _______ 

A) More than 150 years   B) More than 400 years 

C) More than 300 years   D) More than 500 years 
 

2) Louis Braille invented _______ 

A) Pen    B) Zero    C) Motor   D) Braille script 
 

3) The Child Act was passed on _______ 

A) 1986   B)1987    C)1988   D)19993) 
 

4) Children who are away from education are called _______ children. 

A) Deprived   B) Disabled    C) Uneducated  D) Educated 
 

5) _______ This is the center of education. 

A) Parents   B) Children    C) Society   D) Institution 
 

6) Children up to _______ years of age come to kindergarten. 

A) Three to six  B) Four to five   C) Six to six   D) Three to ten 
 

7) Children develop _______ in kindergarten. 

A) All-round   B) Less    C) More   D) Less 
 

8) _______ This is also a kind of hobby center. 

A) Children's house  B) Community house   C) Cultural house  D) Parenting house 
 

9) _______ is a major problem in the world. 

A) Population explosion  B) Pollution   C) River pollution  D) Air pollution 
 

10) Remand home bribe is called _______  

A) Acceptance planet or correction planet   B) Children's house 

C) Community house      D) Cultural house 

 
 



 

 
Question 2nd. Write notes. (Any 03)       (20) 

1) Disadvantages of the disabled 

2) Social education 

3) Child welfare 

4) Population education 

5) Environment 

6) Population explosion 

 

Question 3rd. Write detailed answers. Any (03)      (20) 

1) Space problem of children's schools? 

2) How to provide education to destitute children? 

3) Advantages of kindergartens.? 

 

Question 4th. Write long answers. (Any 1)       (20) 

1) Mention two disadvantages of a large family? 

2) Mention the problems of children? 

 

Question 5th. Write long answers.        (20) 

Explain the importance of education of socially disadvantaged children? 

 

*************************************** 
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Q. No. 1) Multiple choice questions.        (10) 

1. Which generation of computers used vacuum tubes?  
a) First Generation b) Second Generation    c) Third Generation d) Fourth Generation 

2. The central processing unit (CPU) is responsible for:  
a) Displaying output   b) Data processing and execution of instructions 
c) Storing data    d) Inputting data 

3. What does the acronym "DOS" stand for?  
a) Disk Operating System  b) Dynamic Operating System 
c) Data Operating System  d) Digital Operating System 

4. Which type of operating system is designed to handle a single user at a time?            a) 
Multi-user OS b) Single-user OS c) Real-time OS d) Network OS           
                                        

5. Which of the following is not a category of software?                                                                   
a) System software  b) Application software  c) Utility software  d) Hardware software 
 

6. Which key combination is used to save a document in MS Word?                                         
a) Ctrl + O     b) Ctrl + S          c) Ctrl + P           d) Ctrl + N 
 

7. What is the main purpose of an operating system?                                                               a) 
To manage hardware and software resources                       b) To store data 
c) To provide internet connectivity                                          d) To create documents 
 

8. In Windows, what does the "Recycle Bin" do?                                                                     a) 
Permanently deletes files                   b) Stores recently downloaded files 
c) Stores deleted files temporarily         d) Organizes files into folders 
 

9. Which of the following is NOT a type of peripheral device?                                                             
a) Printer          b) Mouse              c) CPU                   d) Keyboard 
 

10. The process of formatting text in MS Word includes:                                                                   
a) Changing the font style                              b) Adjusting margins 
c) Inserting page numbers                             d) All of the above 

Q. No. 2) Write Short Note (Any Five )       (10) 
 

1. Explain Evolution of Personal Computers. 

2. Explain Generation of Computers and their characteristics. 

3. Purpose and Services of an Operating System. 



 

4. Difference between DOS and Windows Operating Systems. 

5. Explain Components of a Computer System. 

6. What is mail merge? 

7. What is Linux operating system? 

 

Q. No. 3) Write Answer in Details. (Any Two)      (10) 

 

1. Explain the different types of operating systems. Discuss their        

   characteristics with examples. 

2. Discuss the components of a computer system, including the CPU,  

    input/output devices, and storage devices. 

3. Describe the process of creating and saving a document in MS Word.  

   Also, explain how to format text and adjust page settings. 

 

Q. No. 4) Write long Answer. (Any One)       (10) 

 

1. Explain the various categories of software. How do system software and application  

   software differ? 

2. Describe the features of MS Word that allow you to enhance your document, including  

    adding images, headers/footers, and applying borders and shading. 

 

Q. No. 5) Write long Answer. (Any one)        (10) 

1. Discuss in detail the concept and working with files and folders in an operating system,  

    focusing on the management of data in Windows OS. 

2. What are the advanced features of MS Word such as mail merge, tables, graphics, and  

    templates? Explain how to use them effectively in document creation. 

 
******************************** 
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Q. No. 1) Multiple choice questions.        (10) 

1. Which of the following is the shortcut to bold text in MS Word? 
a) Ctrl + I b) Ctrl + U c) Ctrl + B  d) Ctrl + Shift + B 
 

2. In MS Excel, what is the default format for a cell? 
a) Text   b) General  c) Number d) Date 
 

3. Which function is used to find the maximum value in a range of cells in MS Excel? 
a) MIN()  b) SUM()  c) MAX() d) AVERAGE() 
 

4. In MS Word, which tab contains the options to insert a table? 
a) Home  b) Insert  c) Layout d) Review 
 

5. In MS Excel, which of the following is a way to sort data? 
a) Click the Filter button  b) Use the Sort & Filter group under the Data tab 
c) Use the Insert tab   d) Use the Format tab 
 

6. What does the "Wrap Text" option do in MS Excel? 
a) Formats text with a specific style  b) Automatically fits text within a cell 
c) Changes the text orientation  d) Moves text to the next cell 
 

7. In MS Word, which of the following options can be used to insert a picture? 
a) Insert > Image  b) Insert > Clip Art 
c) Insert > Picture  d) Insert > Shape 
 

8. Which of the following is used to calculate the total sum of a range of cells in MS Excel? 
a) COUNT()  b) AVERAGE() c) SUM() d) IF() 
 

9. How can you insert a page number in MS Word? 
a) Insert > Header & Footer > Page Number  b) Layout > Insert Page Number 
c) View > Page Number    d) Home > Page Number 
 

10. What is the purpose of the "Merge & Center" option in MS Excel? 
a) To combine cells and center text  b) To center the content within a cell 
c) To merge data from different cells  d) To insert a chart 
 

  



 

 
Q. No. 2) Write Short Note (any Five)       (10) 

1. Explain Functions in MS Excel.  

2. Explain Page Layout and Formatting in MS Word. 

3. Explain Cell Referencing in MS Excel.  

4. Inserting Tables in MS Word. 

5. Explain Sorting and Filtering Data in MS Excel. 

6. Define spreadsheet. 

7. How to protect a Work book? 

Q.No.3.) Write Answer in Details. (Any Two)      (10) 
1. Explain the process of creating a new document, editing text, and formatting in MS Word. 

2. Discuss the various types of chart options in MS Excel and how to create a basic chart. 

3. What are the different types of data validation in MS Excel? Explain how to apply data 

validation. 

 

Q.No.4) Write Long Answer (any one).       (10) 
1. Explain how to work with formulas in MS Excel. Describe the usage of basic functions like 

SUM, AVERAGE, COUNT, and IF. 

2. Describe the process of formatting a document in MS Word, including adjusting margins, line 

spacing, font styles, and paragraph formatting. 

 

Q.No.5) Write Long Answer. (any one)       (10) 
1. Explain the steps involved in creating, formatting, and printing a document in MS Word. 

Include the use of headers, footers, and page numbers. 

2. Discuss the concept of cell references, and describe how to use cell referencing in formulas in 

MS Excel. Explain the difference between relative, absolute, and mixed references. 
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Q. No. 1) Multiple choice questions.        (10) 

1. What is the file extension of a PowerPoint presentation? 

a) .pptx b) .docx c) .xlsx  d) .pdf 

 
2. Which view is used to create speaker notes in PowerPoint? 

a) Slide Sorter View b) Slide Show View c) Notes Page View d) Reading View 

 
3. In MS-Access, a primary key is used to: 

a) Define relationships between tables.  b) Store duplicate values. 

c) Sort data.      d) Delete records. 

 
4. What is the default port for HTTP? 

a) 20  b) 21  c) 80   d) 443 

 
5. What is the shortcut key to insert a new slide in PowerPoint? 

a) Ctrl + N  b) Ctrl + M  c) Ctrl + S  d) Ctrl + D 

 
6. In MS-Access, a query is used to: 

a) Modify the database structure.  b) Retrieve specific data from a database. 

c) Design tables.    d) Delete a database. 

 
7. What does "URL" stand for? 

a) Uniform Resource Locator   b) Unique Reference Link 

c) Universal Reference Locator  d) Uniform Resource Link 

 
8. The Internet is an example of: 

a) LAN  b) MAN  c) WAN  d) PAN 

 
9. In PowerPoint, which feature allows you to apply the same design to all slides? 

a) Slide Master b) Theme Builder c) Slide Sorter           d) Design Checker 



 

 
10. MS-Access is primarily used for: 

a) Word Processing    b) Database Management 

c) Graphic Design    d) Spreadsheets 

 
Q. No. 2) Write Short Note (Any Five )       (10) 
 

1. Explain Slide Layouts in PowerPoint. 

2. Explain Primary Key in MS-Access. 

3. Explain Role of Hyperlinks in Internet. 

4. Explain Animation Effects in PowerPoint. 

5. Explain Database Relationships in MS-Access. 

6. Explain Role of DNS in Internet Functioning. 

7. What is WWW?  

 

Q. No. 3) Write Answer in Details. (Any Two)      (10) 
 

1. Explain the steps to create a table in MS-Access and define its fields. 

2. Describe the use of primary keys and foreign keys in MS-Access with examples. 

3. How do you insert and format a chart in PowerPoint? Explain with steps. 

 

Q. No. 4) Write long Answer. (Any One)       (10) 

 

1. Explain the process of designing a database in MS-Access, including the creation of tables, 

forms, queries, and reports. 

2. Explain the importance of animations and transitions in PowerPoint presentations with 

examples. 

 

Q. No. 5) Write long Answer. (Any one)        (10) 

 

1. Discuss in detail the various views available in PowerPoint and their uses. 

2. Explain the advantages and disadvantages of the Internet in modern life. 

 

******************************** 
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Q.No.1) Multiple choice questions or Fill in the blanks (15) 

 

1. What is a stock? 
a) A bond issued by a company                         b) A share in the ownership of a company 
c) A type of government security                       d) A loan given to a company 

 

2. What does the term "bull market" refer to? 
a) A market where prices are falling   b) A market where prices are stable 
c) A market where prices are rising   d) A market with low trading volume 

 

3. What is the primary purpose of the stock exchange? 
a) To set company prices     b) To regulate the currency market 
c) To provide a platform for buying and selling stocks  d) To control inflation 

 

4. What is a dividend? 
a) The amount paid to shareholders by the company out of its profit 
b) The price paid to buy a stock    c) The market value of a company's shares 
d) The amount of money a company borrows from the market 

 

5. What is the main function of a stockbroker? 
 a) To set stock prices      b) To advise on government policy 
c) To facilitate the buying and selling of stocks   d) To create new companies 

 

6. What is the meaning of market capitalization? 
a) The total value of a company’s debt      b) The total value of all outstanding shares of a 
company 
c) The value of a company’s real estate  d) The revenue generated by a company annually 

 

7. Which of the following is an example of a primary market? 
a) Buying shares of a company on the stock exchange 
b) A company issuing new shares to the public for the first time (IPO) 
c) A company buying back its own shares 
d) A company trading bonds with other investors 

 

8. What does "liquidity" in the stock market refer to? 
a) The stability of a company’s stock price  
b) The ability to buy or sell an asset quickly without affecting its price 
c) The regulation of the stock market        d) The amount of tax a company pays on its earnings 

 

9. What is a stock index? 
a) A record of all shares of a company   
b) A group of stocks representing a particular sector or market 
c) A form of stock that pays a higher dividend  d) A type of bond issued by a company 

 



 

10. Which of the following is NOT a type of order used in the stock market? 
a) Market order    b) Limit order 
c) Stop order    d) Mortgage order 
 

11. What is the primary function of the stock market? 
a) To provide loans to companies  b) To facilitate the exchange of goods 
c) To buy and sell company shares  d) To control inflation 
 

12. What does the term "bear market" refer to? 
a) A market with rising prices   b) A market with falling prices 
c) A market with stable prices   d) A market with a lot of trading activity 
 

13. What is a mutual fund? 
a) A type of bond issued by the government 
b) A pool of money collected from investors to buy a variety of stocks, bonds, or other assets 
c) A private investment in a single stock 
d) A loan given by an investor to a company 
 

14. What is the role of the Securities and Exchange Commission (SEC)? 
a) To regulate the stock prices   b) To create new stocks 
c) To ensure transparency and fairness in the stock market  
d) To set the interest rates in the market 
 

15. What is the price-to-earnings (P/E) ratio? 
a) The ratio of a company’s debt to equity  b) A measure of the company’s 
profitability 
c) The price of a stock divided by the company’s earnings per share 
d) The total value of a company’s stock 
 

Q.No.2) Write Short Note (any Five) (15) 
 

1. What is the Stock Market? 
2. What are Shares? 
3. What is a Stock Exchange? 
4. What is a Stockbroker? 
5. What is a Dividend? 
6. What is Market Capitalization? 
 

Q.No.3.) Write Answer in Details.  (Any Two) (15) 
 

1. What is the Role of Investors in the Stock Market? 
 

2. What is the Difference between Primary and Secondary Markets? 
 

3. What is an Initial Public Offering (IPO)? 
 

Q.No.4) Write Long Answer (Any Three).                                                                                            (15) 
 

1. What is Market Capitalization? 
 

2. What are Dividends? 
 

3. What is a Stockbroker? 
 

4. What is the Stock Market 
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Q.No.1) Multiple choice questions or Fill in the blanks 
 (15) 
1. What is the primary goal of value investing? 
a) To focus on high-growth stocks 
b) To buy undervalued stocks with strong potential for appreciation 
c) To invest in government bonds   
d) To engage in high-frequency trading 
 
2. Which of the following ratios is most commonly used to assess the profitability of 
a company in relation to its shareholders' equity? 
a) Price-to-earnings (P/E) ratio    b) Dividend payout ratio 
c) Return on equity (ROE)    d) Price-to-book (P/B) ratio 
3. What is the beta of a stock used to measure? 
a) The company's earnings growth b) The stock’s volatility relative to the overall market 
c) The company's dividend payout d) The stock's price-to-earnings ratio 

4. What does a high P/E ratio generally indicate? 

a) The stock is undervalued  
b) The stock is expensive relative to earnings 
c) The company has high debt levels 
d) The company has low growth potential 

5. Which of the following best describes a growth stock? 

a) A stock from a company that pays high dividends 
b) A stock from a company that has slow but steady growth 
c) A stock from a company expected to grow at an above-average rate compared to the market 
d) A stock from a company with high earnings but no potential for growth 
 
6. What does the PEG ratio help investors assess? 

a) The company’s debt-to-equity ratio 
b) The price-to-earnings growth rate of a stock 
c) The market value of a company's assets 
d) The profitability of a company relative to competitors 

  



 

7. Which of the following would most likely be considered a defensive stock? 

a) A technology stock with high growth potential 
b) A utility company stock that provides essential services 
c) A speculative biotechnology company stock 
d) A small-cap stock in a volatile industry 

8. What is market timing in the context of share investment? 

a) Holding a stock for the long-term to benefit from dividends 
b) Attempting to predict short-term market movements and buy or sell based on these 
predictions 
c) Focusing only on dividend-paying stocks 
d) A strategy of purchasing a wide range of stocks and holding them 

9. Which of the following is a technical analysis tool used to predict stock price 
movements? 

a) Earnings per share (EPS) 
b) Moving averages 
c) Return on assets (ROA) 
d) Dividend yield 

10. What does the current ratio measure? 

a) The profitability of a company 
b) The ability of a company to pay its short-term liabilities with its short-term assets 
c) The amount of debt in relation to equity 
d) The company’s market value 

11. What is an example of a liquid asset in the context of stock investment? 

a) Real estate 
b) Stocks listed on major stock exchanges 
c) Fine art 
d) Company bonds that are not traded publicly 

12. What does a dividend yield of 5% indicate? 

a) The company is paying a 5% dividend of its market capitalization 
b) The company’s stock price has increased by 5% 
c) The company’s dividend is 5% of the stock's current price 
d) The company's earnings have increased by 5% 

13. What is the main goal of index investing? 

a) To outperform the market by picking high-growth stocks 
b) To replicate the performance of a specific market index, such as the S&P 500 
c) To focus only on dividend-paying stocks 
d) To time the market for short-term profits 



 

14. Which of the following is a potential risk associated with margin trading? 

a) Increased dividend payments 
b) Increased leverage and potential for larger losses 
c) Guaranteed returns 
d) A reduction in transaction fees 

15. What does portfolio diversification help an investor achieve? 

a) Reducing risk by investing in different types of assets and industries 
b) Maximizing returns by investing in a single asset class 
c) Concentrating all investments in growth stocks 
d) Speculating on high-risk stocks to achieve higher profits 

 

Q.No.2) Write Short Note (any Five) (15) 

    1. How does technical analysis aid in share investment? 

   2. What role does fundamental analysis play in share investment? 

   3. What are the risks involved in share investment? 

   4. How can diversification minimize risk in share investment? 

   5. What are the benefits of long-term share investment? 

   6. What are the strategies for successful share investment? 

Q.No.3.) Write Answer in Details.  (Any Two) (15) 

    

   1. What are the key principles of share investment? 

  2. How does technical analysis aid in share investment? 

  3. What role does fundamental analysis play in share investment? 

Q.No.4) Write Long Answer (Any Three).                                                                                    (15) 

 1. What are the risks involved in share investment? 

 2. What kind of stocks should be avoided for investment? 

 3. Corporate action 

 4. Is investing in small-caps more profitable than blue-chip companies? 
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Q.No.1) Multiple choice questions or Fill in the blanks    (10) 

1. The sound /ʃ/ as in the word "ship" is called a __________. a) Voiceless fricative 
b) Voiced fricative 
c) Voiceless plosive 
d) Voiced plosive 

2. The term "phoneme" refers to: 
a) A single sound unit 
b) A combination of sounds 
c) A set of syllables 
d) A system of rules in a language 

3. The primary stress in the word "dictionary" falls on: 
a) First syllable 
b) Second syllable 
c) Third syllable 
d) Fourth syllable 

4. Which of the following words contains a diphthong? 
a) Bit 
b) Boat 
c) Coin 
d) Cut 

5. The voiced dental fricative is represented by the symbol: 
a) /θ/ 
b) /ð/ 
c) /f/ 
d) /v/ 

6. The syllable structure "CVC" stands for: 
a) Consonant-Vowel-Consonant 
b) Consonant-Vowel-Vowel 
c) Consonant-Consonant-Vowel 
d) Vowel-Consonant-Consonant 

7. The weak form of the word "and" is pronounced as: 
a) /ænd/ 
b) /ənd/ 
c) /ɑnd/ 
d) /ænd/ 



 

8. Intonation refers to the: 
a) Stress on individual words 
b) Rising and falling pitch patterns 
c) Speed of speech 
d) Pronunciation of consonants 

9. Which of the following is NOT a feature of connected speech? 
a) Elision 
b) Assimilation 
c) Word stress 
d) Linking 

10. The word "record" can be a noun or a verb depending on: 
a) Stress 
b) Syllable count 
c) Vowel length 
d) Diphthongs 

 
Q.No.2) Write Short Note (any Four)       (20) 

1. Vowels and consonants 

2. Syllables and the CVC pattern 

3. Rules for word accent 

4. Weak forms and strong forms 

5. Accent patterns in connected speech 

6. Rising tone, falling tone, and intonation 

 
Q.No.3) Write Answer in Details. (Any Two)      (20) 

1. Explain the concept of phonemic transcription and its importance in phonetics. 

2. Describe the various types of consonant sounds with examples. 

3. Discuss the role of stress in English and its effect on word meaning. 

 
Q.No.4) Write Long Answer (any one).       (20) 

1. Explain the different types of intonation patterns in English with suitable examples. 

2. Discuss the features of connected speech and their importance in natural spoken English. 

 
Q.No.5) Write Long Answer (any one). (10) 
 

1. Define transcription and explain the difference between broad and narrow transcription. 
Provide examples. 

2. Discuss the rules of word accent and their impact on word stress in connected speech. 
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Q.No.1) Multiple choice questions or Fill in the blanks     (10) 

1. Which of the following phrases can be used for greeting someone? 
a) Good evening!    b) See you later! 
c) I don’t think so.    d) Sorry to bother you. 

2. The correct way to introduce yourself is: 
a) What’s your name?    b) Hi, I’m [your name]. 
c) Can I help you?    d) Excuse me, where’s the bank? 

3. How do you politely decline an invitation? 
a) No, I won’t.     b) I’m sorry, I already have plans. 
c) I’ll try, but I’m not sure.   d) Why should I? 

4. A phrase used to express gratitude is: 
a) Thank you very much.   b) Please wait. 
c) That’s too bad.    d) What time is it? 

5. Complimenting someone can be done by saying: 
a) Well done on your achievement!  b) Sorry for being late. 
c) Please give me your address.  d) I have a problem. 

6. To apologize for a mistake, you can say: 
a) It’s not my fault!    b) I’m really sorry for the trouble caused. 
c) What are you talking about?  d) Let’s agree to disagree. 

7. A phrase used when seeking permission is: 
a) Can I leave early today?   b) You must leave now. 
c) Why should I ask?    d) That’s not necessary. 

8. At the railway station, which phrase is correct? 
a) Can I have a return ticket to Pune, please?  b) Please give me a passport. 
c) Is there a hospital nearby?    d) How do I log in? 

9. At the library, you might ask: 
a) Can I borrow this book for a week? b) Where’s the nearest ATM? 
c) Is this dish vegetarian?   d) What’s the arrival time? 

10. While booking a room at a hotel, you would say: 
a) I’d like to reserve a double room for two nights. 
b) Can I apply for a bank account here? 
c) How much is the fine for late return? 
d) What’s the departure time? 



 

 
 
 
Q.No.2) Write Short Note (any Four)       (20) 

1. Greeting and introducing oneself. 

2. Making requests and expressing gratitude. 

3. Seeking permission and apologizing. 

4. Using English at the railway station or bus station. 

5. Expressing sympathy and regret. 

6. Complimenting and congratulating. 

 
Q.No.3) Write Answer in Details. (Any Two)      (20) 

1. Discuss how to use English at the bank or post office with examples of typical phrases. 

2. Explain the importance of politeness in making requests and seeking permission in English. 

3. Write a detailed note on using English at a travel agency, including phrases for booking 
tickets. 

 
Q.No.4) Write Long Answer (any one).       (20) 

1. Write a dialogue between two people at the college canteen discussing their food preferences 
and plans. 

2. Draft a conversation between a customer and a police officer at the police station, reporting a 
lost item. 

 
Q.No.5) Write Long Answer (any one).       (10) 

1. Imagine you are at a medical shop. Write a dialogue between you and the shopkeeper, 
explaining your need for medicine and asking for instructions. 

2. Write a conversation between a librarian and a student asking for help in finding books and 
borrowing them. 

 
************************************* 
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Q.No.1) Multiple choice questions or Fill in the blanks (10) 

1. A noun is a word that: 
a) Describes an action    b) Names a person, place, or thing 
c) Connects two clauses   d) Expresses a strong feeling 

2. The word "beautifully" is an example of: 
a) Adjective     b) Verb 
c) Adverb     d) Noun 

3. The past tense of the verb "run" is: 
a) Runs     b) Running 
c) Ran      d) Run 

4. An example of a definite article is: 
a) A      b) An 
c) The      d) Of 

5. A sentence that expresses a command is called: 
a) Declarative sentence   b) Interrogative sentence 
c) Imperative sentence   d) Exclamatory sentence 

6. The synonym of "happy" is: 
a) Sad      b) Cheerful 
c) Angry     d) Confused 

7. The antonym of "start" is: 
a) Begin     b) Pause 
c) Continue     d) Stop 

8. Identify the correct sentence pattern: "She gave me a gift." 
a) SVO     b) SVIODO 
c) SVC      d) SVOC 

9. The process of forming a new word by adding a prefix or suffix is called: 
a) Word formation    b) Compounding 
c) Tenses     d) Inflection 

10. An example of a compound sentence is: 
a) I like tea.     b) I like tea, and he likes coffee. 
c) Do you like tea?    d) Wow, what a beautiful day! 

 
 



 

 
 
Q.No.2) Write Short Note (any Four) (20) 

1. Functions of nouns and pronouns. 

2. Types of articles and their uses. 

3. Formation of words using prefixes and suffixes. 

4. Importance of synonyms in communication. 

5. Role of tenses in sentence formation. 

6. Sentence patterns and their examples. 

 
Q.No.3) Write Answer in Details. (Any Two) (20) 

1. Explain the different parts of speech with examples. 

2. Write a detailed note on the different types of sentences with suitable examples. 

3. Discuss the importance of learning antonyms and provide examples. 

 
Q.No.4) Write Long Answer (any one). (20) 

1. Write an essay on the peculiarities of the English language and how they affect learners. 

2. Explain in detail the uses of tenses with examples. 

 
Q.No.5) Write Long Answer (any one) (20) 

1. Write a comprehensive note on word formation, explaining prefixes, suffixes, and 
compounding with examples. 

2. Discuss the importance of articles in sentence construction, giving suitable examples of their 
usage. 
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Q. 1. A) Choose the Correct Alternative.      10 

1) Which option is used in Tally to Closed opened Company.  

A)  Gateway of Tally  B) Alter C) Company Information    D) Shut 

Company. 

 2) Trial Balance in Prepared on ………….Basis. 

A) Monthly   B) Annually      C) Half Yearly       D) Any of the Above 

3) TDS Stands For. 
A) Tax Deducted at Source   B) Tax Collected at Source 

          C) Goods and Service Tax  D) Goods Supply Tax 
 

4) Latest version of Tally package is.... 

 A)  Tally 9  B) Tally Prime C) Tally ERP-9          D) Tally 8.1 

5) How many primary groups are there in Tally? 

A) 28  B) 34  C) 15   D) 9 

6) …….. Shortcut key used to activate calculator in Tally. 

A) Ctrl+A  B) Alt+P C) Ctrl+X         D) Ctrl+N 

7) What are the types Of Account? 

 A) 5  B) 7  C) 3  D)1 

8)  Which Shortcut key is pressed to view features in Tally? 

A. F10      B. F11     C.  F12      D. F1 

9) Function key F9 is used for ------- voucher. 

  A) Sales B) Purchases     C)Receipt   D)Payment 



 

10) Tally Package Developed By…... 

A) Windows  B) Tally Solution       C) Income Tax      D) All of this  
 

B) Fill in the Blanks                 5 

1) GST Stands For…………….. 

2) The principle “Debit the receiver and credit the giver” is related to……Ac. 

3) In Tally you Get currency symbol option from _______ menu. 

4) Full form of PAN Card……………… 

5) F12 is known as ……………… 
 
C) State True or False          5 
 
1) Ctrl+P Short cut Key is used to Print Any Report in tally. 
2) Voucher Type are located in Account Voucher menu. 
3) Debit the Receiver Credit the giver. 
4) In Tally Delete the Ledger Alt+D Shortcut key is used. 
5) BOM Stands For Bills of Material 

 
Q.2. A) Answer the Following (Any 3)       15 
 
1) Explain Journal Voucher Type in Tally ERP 9 
2) What is Group in Tally?  Explain List of Group. 
3) What are Assets? Explain Type of assets. 
4) Explain Various Function Key In Tally ERP 9. 
 
B) Explain company creation in tally With Example?       5 
 
Q.3. Describe / Long Answer (Any 2)        20 
1) What is TDS Explain in Details?2) What is GST Explain in Details? 
3) What are advantage of Computerized Accounting?  
 
Q.4. Write Short Notes (Any 4)         20 
 
1) Software Maintenance & Upgrades    

2) Bank Reconciliation Statement   

3) Introduction to Inventory   

4) Payroll.   

5) Security. 



 

 

Q.5.Journalized the Following Transaction in Details.  (Any 10)   20 
 

1. Mr. Sandesh Started Business with cash Rs.95,000/- Building Rs.3,65,000/- 

Furniture RS. 85,000/- Machinery Rs.3,80,000/- Land Rs.6,45,000/-. 

2. Open a bank account in State of  India with Depositing Rs.9,30,000/- 

3. Purchase Goods Rs. 3,20,000/- FromRoyal Trading company Pune. & Add Extra 

18% GST. 

4. Amount Paid Rs. 3,77,600/- to Royal Trading Company Pune. SBI Cheque 

No.108265. 

5. Interest received Rs. 4500/- on State Bank of India account. 

6. Cash Withdraw Rs 35,000/- in State Bank of India. 

7. Purchase Still Rs.40,000/- From Shri Still Corporation Mumbai. &Add Extra 

28% GST. 

8. Paid Wages Rs. 1200/- By Cheque No: 108267 

9. Cash Sales Rs.25,000/-. 

10.  Paid Income Tax Rs.17,500/- By Cheque No. 108268. 

11.  Purchase Goods Rs.65,000/- From Shri  S Turn House Pune. & add Extra 12% 

GST. 

12.  Electricity Charges Paid Rs.7500/- By Cash.  

 

*************************** 
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 Q.No.1) एकािधक िनवड ÿĳ (बहò िवकÐपीय ÿĳ) (Multiple choice questions)             
20 marks 

1) तवकìर (Öटाचª), साखर आिण µलकूोज मु́ यतः ------- पदाथाªचे उदाहरण आह े
A)ÿिथने  B) िवटािमन  C) िपĶमयपदाथª D)खिनज  
1) तौकìर (Öटाचª), चीनी और µलूकोज मु́ य łप स े------- पदाथŎ के उदाहरण ह§ 

A) ÿोटीन B) िवटािमन  C) िपĶमयपदाथª D)खिनज 
1) Starch, sugar and glucose are mainly examples of ------- substances. 
A) Protein  B) Vitamins C) Carbohydrates D) Minerals 
 

2) दाळी, अडंी आिण मास ेयामÅय े------- िवपुल ÿमाणात िमळतो 
A)ÿिथने     B)जीवनसÂव े C) िपĶमय  D)खिनज 
2) दाल¤, अडें और मछली -------- स ेभरपूर ह§ 
 A) ÿोटीन B) िवटािमन  C) िपĶमयपदाथª D)खिनज 
2) Pulses, eggs and fish are rich in ------- 
A) Protein  B) Vitamins C) Carbohydrates D) Minerals 
 

3) ------- ह ेघटक आहारातील तेल, तपू, लोणी, दधू, अडंी या पदाथाªत िमळतो 
A)खिनज   B)िपĶमय पदाथª C)िÖनµध पदाथª  D)वरील पैकì  कोणताही नाही 
3)------यह तÂव खाī तेल, घी, म³खन, दधू, अडें म¤ पाया जाता ह ै
 A)खिनज   B)िपĶमय पदाथª C)िÖनµध पदाथª  D) उपरोĉ म¤ स ेकोई नहé 
3) ------- It is found in dietary oils, ghee, butter, milk and eggs 
A) Minerals B) Carbohydrates C) Fat D) None of the above 
 

4)Digestive Enzyme मळेु िपĶमय पदाथाªचा łपांतरण ------- मÅय ेहोतो 
A)अिमनो आÌल ेB) फॅटी आÌल  C)µलकुोज D)वरीलपैकì कोणतेही नाही 
4)पाचन एंजाइम Öटाचª को ------- म¤ पåरवितªत करता ह ै
 A) अमीनो एिसड B) फैटी एिसड C) µलकूोज D) उपरोĉ म¤ स ेकोई नहé 
4) Digestive enzyme converts fatty substances into ------- 
A) Amino acids B) Fatty acids C) Glucose D) None of the above 
 
 
5) Digestive Enzyme मळेु ÿिथनाचें łपांतरण  ------- मÅय ेहोते 
A)अिमनो आÌल ंB)फॅटी आÌल ंC)µलकुोज D)वरीलपैकì कोणतेही नाही 
5)Digestive Enzyme ÿोटीन को ------- म¤ पåरवितªत करता ह ै
 A) अमीनो एिसड B) फैटी एिसड C) µलकूोज D) उपरोĉ म¤ स ेकोई नहé 



 

5) Due to Digestive Enzyme Protein is converted into ------- 
A) Amino acids B) Fatty acids C) Glucose D) None of the above 
 

6) िÖनµध पदाथाªचा łपांतरण ------- मÅये Digestive Enzyme मळेु होतो 
A)µलुकोज  B)फॅटी आÌल ं C)अिमनो आÌल ंD)वरीलपैकì कोणतेही नाही 
6) पाचक एंजाइम Ĭारा वसायुĉ पदाथª का ------- म¤ łपांतरण 
 A) µलकूोज B) फैटी एिसड C) अमीनो एिसड D) उपरोĉ म¤ स ेकोई नहé 
6) Digestive enzyme converts fat into ------- 
A) Glucose B) Fatty acids C) Amino acids D) None of the above 
 

7) अÆनमागª हा मखुपासून गदुाĬारा पय«त साधारणतः ------- लांबी असते 
A)नऊ मीटर B)नऊ स¤टीमीटर  C)नऊ िमिलमीटर D)वरीलपैकì कोणतेही नाही 
7) आहार पथ आम तौर पर मुंह स ेगदुा तक लगभग ------- लबंाई का होता ह ै
 A)नौ मीटर B)नौ स¤टीमीटर C)नौ िमलीमीटर D)उपरोĉ म¤ स ेकोई नहé 
7) The Alimentary Canal is usually ------- long from mouth to anus 
A) Nine meters B) Nine centimeters C) Nine millimeters  D) None of the above 
 

8) बालपणी येणारे दातांना ------- Ìहणतात 
A)वाळूच ेदात B)लोखडंाचे दर C)दधुाचे दात D)ह°ी दात 
8) बचपन म¤ िनकलन ेवाल ेदातं कहलाते ह§------ 
 A)रेत के दातं बी)लोह ेके दातं सी)दधू के दातं डी)हाथी के दातं 
8) Childhood teeth are called ------- 
A) Sand teeth B) Iron teeth C) Milk teeth D) Elephant teeth 
 

9) मानवी आयÕुयात ------- वेळा दात येतात 
A)दोन B)पाच C)सहा D)आठ 
9) मानवी आयÕुयात ------- वेळा दात येतात 
A)दोन B)पाच C)सहा D)आठ 
9) Teeth appear in human life ------- times 
A) Two B) Five C) Six D) Eight 
 

10) बालपणी येणारे दातांची सं´या साधारणपणे ------- असते 
A)10 B)20 C)32 D)36 
10) बचपन म¤ िनकलने वाले दातंŌ कì सं´या आमतौर पर ------- होती ह.ै 
10) The number of teeth in childhood is usually ------- 
A) 10 B) 20 C) 32 D) 36 
 
 
Q.No2) थोड³यात उ°र िलहा. (कोणÂयाही चार) 
 उ°र स±ेंप म¤ िलख¤ (कोई चार)  
Write Answer in Short (any four)                     16 Marks  
 1) मानवी पेशीच ेमु́ य घटक कोणत ेआहते? 
1)मानव कोिशका के मु́ य घटक ³या ह§? 
1)What are the main components of a Human cell? 
 

 2)ĵसन ÿणालीची ÿमुख वैिशĶ्य ेसागंा. 
2) ĵसन तंý कì ÿमुख िवशेषताओ ंकì łपरेखा ÿÖतुत कर¤। 



 

2)Outline the key features of the respiratory system. 
 

 3) मानवी शरीरातील मºजातंतूं̧ या ऊतéच ेमहßव िवशद करा. 
3)मानव शरीर म¤ तंिýका ऊतक के महÂव पर िवÖतार स ेबताए।ं 
3)Elaborate on the importance of nervous tissue in the human body. 
 

 4) थोरॅिसक Öपाइन¸या ÿाथिमक कायाªची थोड³यात चचाª करा. 
4) थोरॅिसक Öपाइन के ÿाथिमक कायª पर स±ंपे म¤ चचाª कर¤। 
4)Briefly discuss the primary function of the thoracic spine 
 

 5) ĵसनसंÖथेतील वायू̧ या देवाणघेवाणीत गुंतलÐेया ÿाथिमक अवयवाचंी नाव ेसागंा. 
5)ĵसन तंý म¤ गैस िविनमय म¤ शािमल ÿाथिमक अगंŌ के नाम बताइए। 
5)Name the primary organs involved in gas exchange in the respiratory system. 
 

 6) अतंःąावी úंथीच ेउदाहरण īा आिण Âयातनू ąािवत होणाöया हामōनचा उÐलखे करा. 
   6) अतंःąावी úंिथ का एक उदाहरण दीिजए और उसके Ĭारा ąािवत एक हामōन का उÐलेख कìिजए।  
6)Provide an example of an endocrine gland and mention one hormone it secretes. 
 

Q3)  तपशीलवार उ°र िलहा.(कोणÂयाही दोन) 
उ°र िवÖतार से िलख¤.(कोई दो) 
Write Answer in Detail.(Any Two)                                                    14 Marks                              
  
 1) थायरॉईड संÿेरकां̧ या चयापचय आिण वाढीवर होणाöया पåरणामाची चचाª करा. 
1)चयापचय और िवकास पर थायराइड हामōन के ÿभाव पर चचाª कर¤। 
1)Discuss the impact of thyroid hormones on metabolism and growth. 
 

 2) सयंोजी ऊतकांची काय¥ िवÖततृ करा, दोन िविशĶ ÿकार आिण संरचनाÂमक समथªनामÅय ेÂयांच ेमहßव हायलाइट करा. 
2) संयोजी ऊतकŌ के कायŎ पर िवÖतार स ेÿकाश डाल¤, दो िविशĶ ÿकारŌ और संरचनाÂमक समथªन म¤ उनके महÂव पर ÿकाश डाल¤। 
2)Elaborate on the functions of connective tissues, highlighting two specific types and their 
importance in structural support. 
 

 3) धमÆया, िशरा आिण केिशका यां̧ यात फरक करा, Âयां̧ या अिĬतीय वैिशĶ्यावंर आिण काया«वर जोर īा.  संपणूª शरीरात रĉाची कायª±म 
वाहतूक सुिनिĲत करÁयासाठी या वािहÆया एकý कशा ÿकारे कायª करतात यावर चचाª करा. 
 3) धमिनयŌ, िशराओ ंऔर केिशकाओ ंके बीच अतंर कर¤, उनकì अनूठी िवशेषताओ ंऔर कायŎ पर जोर द¤।  चचाª कर¤ िक पूरे शरीर म¤ रĉ के 
कुशल पåरवहन को सुिनिĲत करन ेके िलए य ेवािहकाए ँएक साथ कैस ेकाम करती ह§। 
3)Differentiate between arteries, veins, and capillaries, emphasizing their unique 
characteristics and functions. Discuss how these vessels work together to ensure the efficient 
transport of blood throughout the body. 
 

Q4) लांब उ°र िलहा (कोणतेही एक)  
दीघª उ°र िलख¤ (कोई एक) 
Write Long Answer (Any one)         15 Marks 
 

 1)मýूिपंड, मýूनिलका, मýूाशय आिण मýूमागª यासंार´या मु́ य घटकांची łपरेषा दऊेन, उÂसजªन ÿणालीच ेतपशीलवार िवहगंावलोकन ÿदान 
करा.  शरीरातनू टाकाऊ पदाथª काढून टाकÁयात या ÿणालीची मलूभतू भूिमका ÖपĶ करा. 
1) उÂसजªन ÿणाली का एक िवÖततृ अवलोकन ÿदान कर¤, िजसम¤ गदु¥, मýूवािहनी, मýूाशय और मýूमागª जैस ेइसके ÿमुख घटकŌ कì łपरेखा दी गई 
ह।ै  शरीर स ेअपिशĶ उÂपादŌ को खÂम करन ेम¤ इस ÿणाली कì मौिलक भूिमका कì Óया´या कर¤। 
1)Provide a detailed overview of the excretory system, outlining its major components such as 



 

the kidneys, ureters, bladder, and urethra. Explain the fundamental role of this system in 
eliminating waste products from the body. 
 

2)रĉातील घटक (लाल आिण पाढंöया रĉपशेी, Èलेटलेट्स आिण Èलाझमा) दशªिवणारा स-ुलबेल केलेला आकृती ÖपĶ करा.  ÿÂयेक घटका¸या 
कायाªची चचाª करा. 
2) रĉ के घटकŌ (जैस ेलाल और सफेद रĉ कोिशकाए,ं Èलेटलट्ेस और Èलाºमा) को दशाªन ेवाल ेएक अ¸छी तरह स ेलबेल िकए गए आरेख कì 
Óया´या कर¤।  ÿÂयेक घटक के कायŎ पर चचाª कर¤। 
2)explain a well-labeled diagram illustrating the components of blood( as red and white blood 
cells, platelets, and plasma). Discuss the functions of each component. 
 

Q5 दीघō°री.Long Answers             15 Marks                        
1) मण³याच ेिकती भाग आहते?  ते कोणते?  ÖपĶ करण.े 
1) रीढ़ को िकतन ेभागŌ म¤ बांटा गया ह,ै वे कौन स ेह§?  समझाना। 

1) Spine divided into how many parts ? Which are they?  Explain. 
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 Q.No.1) एकािधक िनवड ÿĳ (बहò िवकÐपीय ÿĳ) (Multiple choice questions)            20 marks 
1) मुळÓयाध खालील िदलेÐया कोणÂया मण³यांचा ÿभावामुळे होते 
A)सøेम B) लंबर 5 C)कॉिक³स (माकडहाड) D)यापैकì कोणताही नाही 
1) łट कैनाल िनÌनिलिखत म¤ से िकस कशŁेक के ÿभाव के कारण होता है 
 A)सøेम B) लंबर 5 C)कॉिक³स  D) इनम¤ से कोई नहé 
1) Hemorrhoids (Piles) are caused by which of the following vertebrae 
A)Sacrum  B) Lumber 5 C) Coccyx D) None of these 
 

2) मोठ्या आतड्यांना ÿभािवत करणारा मणका कोणता आह े
A)लंबर ५ B)लंबर १ C)थोरॅिसक १२ D)थोरॅिसक ११ 
2) कौन सी कशŁेका बड़ी आंत को ÿभािवत करती है? 
A)लंबर ५ B)लंबर १ C)थोरॅिसक १२ D)थोरॅिसक ११ 
2) Which is the vertebra that affects the large intestine? 
A) Lumbar 5   B) Lumbar 1 C) Thoracic 12 D) Thoracic 11 
 

3) लंबर तीन øमांकाचा मण³यामळेु कोणता अवयव ÿभािवत होतो 
A)मोठी आतडी B) िÈलहा C)गभाªशय     D)थायराइड 
3) लंबर Öपाइन नंबर तीन स ेकौन सा अगं ÿभािवत होता ह?ै 
 A) बड़ी आंत B) िÈलहा C)गभाªशय     D)थायराइड 
3) Which organ is affected due to lumbar spine number 3? 
A) Large intestine B) Spleen C) Uterus D) Thyroid 
  

4) लंबर तीनला जर इजा झाली तर खालील पैकì कोणता आजार होऊ शकतो? 
A)नंपसुकÂव  B)मधमुेह C)मुळÓयाध D)यापैकì कोणताही नाही 
4) यिद लÌबर 3 घायल हो जाए, तो िनÌनिलिखत म¤ स ेकौन सी बीमारी हो सकती ह?ै 
 A)नंपसुकÂव  B)मधमुेह C)मुळÓयाध D) इनम¤ स ेकोई नहé 
4) If lumbar three is injured, which of the following diseases can occur? 
A) Impotence B) Diabetes C) Hemorrhoids D) None of these 
 

5) मýूिपंड हा कोणÂया मण³या मळेु ÿभािवत होतो? 
A)लंबर १ B)थोरॅिसक ७ C)थोरॅिसक ११ D)सøेम 
5) िकडनी िकस कशŁेका स ेÿभािवत होती ह?ै 
A)लंबर १ B)थोरॅिसक ७ C)थोरॅिसक ११ D)सøेम 
 
5) Which vertebrae affect the kidneys? 
A) Lumbar 1 B) Thoracic 7 C) Thoracic 11 D) Sacrum 
 



 

6) थोरॅिसक १० कोणता अवयव ला ÿभािवत करतो 
A)िÈलहा B)यकृत C)मýूिपंड D)यापैकì कोणताही नाही 
6) थोरेिसक 10 िकस अगं को ÿभािवत करता ह?ै 
 A)िÈलहा B)यकृत C)मूýिपंड D) इनम¤ से कोई नहé 
6) Which organ is affected by thoracic 10? 
A) Spleen B) Liver C) Kidney D) None of these 
 
7) पायांच ेतळव ेकोणÂया मण³यामुळे ÿभािवत होते 
A)लंबर १ B) लंबर ३ C)लंबर ५ D)यापैकì कोणताही नाही 
7) कौन सी कशŁेका पैरŌ के तलवŌ को ÿभािवत करती ह?ै 
A)लंबर १ B) लंबर ३ C)लंबर ५ D) इनम¤ स ेकोई नहé 
7) Which vertebrae affect the soles of the feet? 
A) Lumbar 1 B) Lumbar 3 C) Lumbar 5 D) None of these 
 
8) मािसक पाळीच ेिवकार वेदनासाठी कोणता मणका ÿभािवत करतो? 
A)लंबर १ B)थोरॅिसक ३ C)लंबर ३ D)थोरॅिसक १२ 

8) मािसक धमª संबंधी िवकार ददª के िलए िकस कशŁेका को ÿभािवत करते ह§? 
A)लंबर १ B)थोरॅिसक ३ C)लंबर ३ D)थोरॅिसक १२ 
8) Which vertebra affects menstrual disorders for pain? 
A) Lumbar 1 B) Thoracic 3 C) Lumbar 3 D) Thoracic 12 
 
9) अिűनल úंथीला ÿभािवत करणारा मणका कोणता आह?े 
A) लंबर १ B) थोरॅिसक ७ C)थोरॅिसक ९ D)लंबर ३ 
9) कौन सी कशŁेका अिधव³ृक úंिथ को ÿभािवत करती ह?ै 
A) लंबर १ B) थोरॅिसक ७ C)थोरॅिसक ९ D)लंबर ३ 
9) Which is the vertebra that affects the adrenal gland? 
A) Lumbar 1 B) Thoracic 7 C) Thoracic 9 D) Lumbar 3 
 
10) अप¤िड³स ला ÿभािवत करणारा मणका कोणता? 
A)लंबर ६ B)सेøम C)थोरॅिसक १२ D)लंबर २ 
10) कौन सी कशŁेका अप¤िड³स को ÿभािवत करती ह?ै 
A)लंबर ६ B)सेøम C)थोरॅिसक १२ D)लंबर २ 
10) Which vertebrae affect the appendix? 
A)Lumbar 6  B) Sacrum C) Thoracic 12 D) Lumbar 2 
 
Q.No 2) Write Answer in short (any four)       16 Marks  
1) ॲ³यÿेुशर चे   कोणÂयाही 4 फायद े  िलहा.                                                                                     
1) ॲ³यÿेुशर के कोई भी 4 लाभ िलिखए। 
1)  Write   on any 4 acupressure advantages. 
 
2)पाठ दखुी Ļा आजारा चे पायावरचे ÿितिबंब िबंदचेू आकृती काढून दाखवा. 
2) पीठ म ेददª  कì तकलीफ  के पैरŌ पर ÿितिबंब िबंद ुका िचý बनाएं। 
2) Draw a diagram of the reflex point on the  feet  for the Upper Back Achache. 
 
3) गडुघेदखुीसाठी हाता व पायावर åरÉल³ेसोलॉजी पॉइंट काढा. 
3)घटुन ेके ददª के िलए हाथ और  पैर पर ÿितिबÌब िबंद ुका िचý बनाएं। 
3)Draw a diagram of the reflex point on the  hand and feet for the Knee pain. 
 



 

4)हात िकंवा पाय यां̧ या दोÆही बाजलूा एकल बाजू̧ या åरÉले³सोलॉजी िबंदूपंैकì कोणतेही 4 िबंदचूे नाव आिण सं´या िलहा. 
4)हाथ या पैर के दोनŌ ओर िकÆहé 4 एकल प±ीय åरÉले³सोलॉजी िबंदओु ंका नाम और सं́ या िलख¤. 
4)Write the name and number of any 4 single sided reflexology points on either side of hand or foot. 
 
5) ऑåरकोलॉजीमÅये काना¸या आकाराच ेमहßव काय आह ेआिण ते संपणूª शरीराशी कस ेसंबंिधत आह?े 
5) ऑåरकोलॉजी म¤ कान के आकार का ³या महÂव ह ैऔर यह परेू शरीर स ेकैस ेसंबंिधत ह?ै 
5) What is the significance of the shape of the ear in Auricology, and how is it related to the entire 
body? 
 
6)सुजोकची Óया´या करा आिण Âयाचे भािषक मूळ ÖपĶ करा. 
6)सुजोक को पåरभािषत कर¤ और इसकì भाषाई उÂपि° कì Óया´या कर¤। 
6)Define Sujok and explain its linguistic origin. 
 
QNo.3) Write Answer in Detail (any two)       14 Marks 
 
1)पोट दखुी या आजारािवषयी मािहती सांगनू हात व पायावरचे ÿितिबंब िबंदचेू आकृती काढून दाखवा.    
1) पेट ददª कì जानकारी बताए ंऔर हाथŌ और पैरŌ पर ÿितिबंब िबंद ुका िचý िदखाएं। 
1) Tell the information about stomach ache and show the diagram of reflex points of stomach ache on 
hands and feet. 
2) मानव शरीराशी हातावर येणारे ÿितिबंब िबंदूशंी साÌयता िवषयी मािहती िलहा.                                     
2) मानव शरीर के साथ हाथ पर ÿितिबंब िबंदओु ंकì समानता िलिखए। 
2) Write down the similarity of reflex points on hand with the human body. 
3)  रĉदाब Ļा आजारािवषयी मािहती िलहóन High B.P  आिण Low BP चे हात व पायावरचे ÿितिबंब िबंदचूे आकृती काढून दाखवा.                                                  
3) रĉदाब कì बीमारी कì जानकारी िलिखए और हाथ व पैरŌ पर हाई बीपी और लो बीपी के ÿितिबंब िबंद ू आकृती िदखाइए। 
 3) Write the information about the disease of blood pressure and show the diagram of High B.P and 
Low BP on the hands and feet. 
  
Q.No. 4) Write Long Answer (Any one)       15 Marks 
1)आयवु¥िदक  ॲ³यÿेुशर व झोनोलॉजी बĥल मािहती िलहा.                                                                                                            
1) आयवु¥िदक  ॲ³यÿेुशर और झोनोलॉजी के बारे म¤ जानकारी िलख¤। 
1) Write a note about Ayurvedic Acupressure & Zonology. 
 
2) ॲ³यÿेुशर Ìहणजे काय? आिण Âया¸या मयाªदा ÖपĶ करा.                                                                                         
2) ॲ³यÿेुशर ³या ह?ै  और उसकì सीमाए ँसमझाइए. 
2) What is acupressure?  And explain its Limitations. 
 
QNo.5) दीघō°री.Long Answers          15 Marks  
1) ॲ³यÿेुशर चे इितहासाबĥल सिवÖतर मािहती िलहा.                                                                                                  
 1) ॲ³युÿेशर के इितहास के बारे म¤ िवÖततृ जानकारी िलख¤. 
 1) Write detailed information about the history of acupressure. 
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 Q.No.1) एकािधक िनवड ÿĳ (बहò िवकÐपीय ÿĳ) (Multiple choice questions)     20 marks 
1) यीन आिण यांग ÿतीकामÅये काळा भाग कोणता ऊज¥ला दशªिवतो 
A)यीन B)यांग C)ची D) यापैकì कोणताही नाही 
1) ियन और यागं ÿतीक म¤ काला भाग िकस ऊजाª का ÿितिनिधÂव करता ह?ै 
A)यीन B)यांग C)ची D)इनम¤ स ेकोई नहé 
1) What energy does the black part represent in the yin and yang symbols? 
A) Yin B) Yang C) Chi D) None of these 
 

2) ऋणाÂमक ऊजाª याला ॲ³यÿेुशर¸या पारंपåरक भाषते काय नाव िदलं आह े
A)Chi B)Yin C)Yang D)यापकैì कोणताही नाही 
2) ए³यÿेूशर कì पारंपåरक भाषा म¤ नकाराÂमक ऊजाª को ³या नाम िदया गया ह?ै 
 A)Chi B)Yin C)Yang D)इनम¤ स ेकोई नहé 
2) What is the name of the negative energy in traditional Acupressure? 
A) Chi B) Yin C) Yang D) None of these 
 

3) वा³य पूणª करा Yang------and Yin ------ 
A)Yang Decides and Yin Decides B)Yang Follows and Yin Follows 
C)Yang Decides and Yin Follows D)यापैकì कोणताही नाही 
3) इस  वा³य को पूरा कर¤ Yang------and Yin ------ 
A)Yang Decides and Yin Decides B)Yang Follows and Yin Follows  
C)Yang Decides and Yin Follows D)इनम¤ स ेकोई नहé 
3) Complete the sentence Yang ------ and Yin ------ 
A) Yang Decides and Yin Decides B) Yang Follows and Yin Follows  
C) Yang Decides and Yin Follows D) None of these 
 

4) खालील अवयवांपैकì ऋणाÂमक ऊजाª मÅये येणार अवयव कोणता 
A)लहान आतडी B)मोठी आतडी C)आतडे   D)यकृत 
4) िनÌनिलिखत म¤ से कौन सा अगं नकाराÂमक ऊजाª के अतंगªत आएगा? 
 A)छोटी आंत B)बड़ी आंत C)आंत D) यकृत  
4) Which of the following organs will come into negative energy? 
A) Small intestine B) Large intestine C) Intestine  D) Liver 
5) िýगणुी ऊÕमाची जोडी ----- अवयवासोबत आह े
A)मोठे आतडी B)फुÉफूस C)Ńदयावरण D)Ńदय 
5) िýगणु ऊÕमा कì जोडी ----- अगं के साथ है 
 A) बड़ी आंत B) फेफड़े C) पेरीकािडªयम D) Ńदय 



 

5) The pair of Triple Warmer is with the ----- organ 
A) Large intestine B) Lungs C) Pericardium  D) Heart 
 

6) िकडनी हा अवयव कोणती ऊजाª ला ÿÖतुत करतो? 
A)Chi B)Yin C)Yang D) वरीलपकैì कोणतेही नाही 
6) िकडनी िकस ऊजाª का ÿितिनिधÂव करती ह?ै 
 A)Chi B)Yin C)Yang D)उपरोĉ म¤ स ेकोई नहé 

6) What energy does the kidney organ represent? 
A) Chi B) YinC) Yang D) None of the above 
 

7) िदवस-राý या उदाहरण मÅये िदवस कोणती ऊजाª आहे? 
A)Yin B)Yang C)Æयूůल D)यापैकì कोणताही नाही 
7) िदन-रात के उदाहरण म¤ िदन कì ऊजाª ³या ह?ै 
 A)Yin B)Yang C)Æयूůल D)इनम¤ स ेकोई नहé 
7) What is the energy of day as per day and night ? 
A) Yin B) Yang C) Neutral D) None of these 
 

8) फुÉफुस ंया अवयव याची जोडी Ìहणनू कोणता अवयव आह े
A)यकृत B)िप°ाशय C)जठर D)मोठी आतडी 
8) कौन सा अगं फेफड़Ō स ेजुड़ा हòआ ह?ै 
 A)यकृत B)िप°ाशय C)जठर D) बड़ी आंत 

8)Which of these organs is a pair of lungs? 
A) Liver B) Gallbladder C) Stomach D) Large intestine 
 

9) ॲ³यÿेुशर चा जÆम समुारे ------- वषाªपवूêचा आह े
A)२०० B)६०० C)६००० D)३०० 
9) ए³यÿेूशर का जÆम लगभग -------- वषª पहले हòआ था 
 ए)200 बी)600 सी)6000 डी)300 

9 ) Acupressure is born about ------- years ago 
A) 200 B) 600C) 6000 D) 300 
 

10)  वा³य पणूª करा :उÂसाह -----,------- ही िनरोगीपणा ची ल±ण आहते 
A)उदासीनता,दखु B)बुĦी,ÿसÆनता C)तनाव,संताप D) वरीलपैकì कोणतेही नाही 
10) वा³य पूरे कर¤ :उÂसाह -----,------- ÖवाÖÃय के ल±ण ह§ 

 A) उदासीनता,दखु B)बुĦ◌ी,ÿसÆनता C)तनाव,संताप D) उपरोĉ म¤ स ेकोई नहé 
10) Complete the sentence: Enthusiasm -----, ------- These are the signs of health 
A) Sad, anxiety B) Wisdom, happiness C) Stress, anguish D) None of the above 
 
 
Q.No 2) खाली िदÐयाÿमाणे मेåरिडयन िबंदंूचे Öथान आिण कायª िलहा (कोणÂयाही चार) 
 नीचे िदए गए अनुसार मेåरिडयन िबंदुओ ंका Öथान और कायª िलख¤ (कोई चार) 
Write Location and Function of Meridian points as given below (any four)        16 
Marks  
1)Liv2   2)St8   3)GV 9  4)CV 4  5)Li 2  6)TW 11 
 
QNo.3) Write Answer in Detail (any two)       14 Marks 
1) उजाª जाÖत िकंवा कमी असÐयास खालील मेåरिडयन¸या ल±णांच ेथोड³यात वणªन करा? 
 (A) उदर मेåरिडयन  (B) Èलीहा मेåरिडयन 



 

1)िनÌनिलिखत मेåरिडयन के ल±णŌ के बारे म¤ स±ंपे म¤ बताए,ं यिद ऊजाª अिधक व कम ह?ै 
 (A) उदर मेåरिडयन (B) Èलीहा मåेरिडयन 
1)Give the brief  on  symptoms of meridian  given below if the energy is high or low? 
(A) Stomach meridian (B) spleen meridian 
 

2)Èलीहा मåेरिडयन िबंदूचंी एकूण सं´या िकती आह?े sp-6 sp-7 चे िठकाण आिण कायª िलहा? 
2) Èलीहा मेåरिडयन िबंदओु ंकì कुल सं́ या ³या ह?ै sp-6 sp-7 का Öथान और कायª िलख¤? 
2)What are the total numbers of spleen meridian points?Write place and function of sp-6 sp-7? 
3)5. लहान आतड्या¸या मेåरिडयन िबंदूंची एकूण सं´या िकती आह,े si-3, si-5 चे Öथान आिण कायª िलहा? 
5. छोटी आतं मåेरिडयन िबंदओु ंकì कुल सं́ या ³या ह,ै si-3, si-5 का Öथान और कायª िलख¤? 
5.What are the total number of small intestine meridian points, Write place & function of si-3, 
si-5? 
 

Q.No. 4) Write Long Answer (Any one)      15 Marks 
1)अवयव घड्याळ िसĦातंानुसार   येणारे मåेरिडयनसची  वेळेबĥल व Ļा संदभाªिवषयी िलहा? 
1)ऑगªन ³लॉक Ãयोरी (अगं घड़ी िसĦातं ) और उसके संदभª के अनुसार  मåेरिडयन के समय के बारे म¤ िलख¤? 
1) Write about  meridian time  according to organ clock theory and its context? 
 
2)मेåरिडयनची नाव ेसांगा आिण मेåरिडयनचा अथª सांगा? 
2) मåेरडीयन के नाम िलिखए और मåेरडीयन का अथª समझाइए? 
2)Write the names of the meridian,& Explain the meaning of the meridian?  
 
QNo.5) दीघō°री.Long Answers          15 Marks  
1)¸युन  वर तपशीलवार ÖपĶीकरण īा?  
1) ¸यनु  पर िवÖतार स ेबताए?ं 
1)Give a detailed explanation on chun? 
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